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Warranty

All products manufactured by ICP DAS are under warranty regarding defective materials for
a period of one year, beginning from the date of delivery to the original purchaser.

Warning

ICP DAS assumes no liability for any damage resulting from the use of this product. ICP DAS
reserves the right to change this manual at any time without notice. The information
furnished by ICP DAS is believed to be accurate and reliable. However, no responsibility is
assumed by ICP DAS for its use, not for any infringements of patents or other rights of third
parties resulting from its use.

Copyright

Copyright @ 2020 by ICP DAS Co., Ltd. All rights are reserved.

Trademark

The names used for identification only may be registered trademarks of their respective
companies.

Contact US
If you have any problem, please feel free to contact us.

You can count on us for quick response.

Email: service@icpdas.com
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1. Introduction

This chapter provides an overview of the WP-2641M-CE7 and its components, and introduces the

fundamental concepts for user familiar.

The WP-2641M-CE7 are equipped a Quad-core Cortex-A9, 1GHz/Core and running a windows CE.NET 7.0
operating system. The optional I/O expansion board, XV-board, provides high-protection 1/0. Using the
built-in Flash and microSD, the WP-2641M-CE7 can save application program, image file and data.

The mobile network module of WinPAC series(Except for WP-2641M-CE7) work on frequencies of
WCDMA 900/2100 MHz, TD-SCDMA1900/2100 MHz, CDMA2000 (BC0) 800 MHz, FDD LTE:B1/B3/BS,
TDD LTE: B38/B39/B40/B41 and GSM 850/900/1800/1900 MHz, WCDMA 2100/1900/900/850 MHz, FDD
LTE:B1/B3/B5/B7/B8/B20 and GSM 850/900/1800/1900 MHz.
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1.1. Features

The WP-2641M-CE7 offer the most comprehensive configuration and remote system upgrade solutions
to meet specific application requirements. The following list shows the hardware and software features

designed to simplify installation, configuration and application.

» Windows Embedded Compact 7.0

P Windows®
K Embedded

Compact 7

* Support PC based software: Visual Studio.NET

* Web server, FTP server, Telnet server

» Local I/0 and Communication Expansion Board

WP-2641M-CE7 is equipped with an /O expansion bus to support one optional expansion board,
called XV-board. It can be used to implement various 1/0O functions such as DI, DO, A/D, D/A,

Timer/Counter

For more information about these available expansion boards, please refer to

http://www.icpdas.com/root/product/solutions/hmi touch monitor/touchpad/xv-board selection

.html
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Various Memory Expansions
WP-2641M-CE7 provides various memory storage options, such as FRAM and

Adapter

microSD. Customers can choose the memory based on their characteristics. - Jro
mg

* 64 KB FRAM: no limit on the number of write-erase cycles.

* microSD/microSDHC: to implement portable data logging applications; supports up to 32 GB.

Unique 64-bit Hardware Serial Number to Protect Your Program

A unique 64-bit serial number is assigned to each hardware device to

protect your software against piracy.

Remote I/0 Module and Expansion Unit

With the built-in RS-485 and Ethernet port, the WP-2641M-CE7 can connect RS-485/Ethernet
remote 1/0O units (RU-87Pn/ET-87Pn) or modules (I-7000/M-7000/ET-7000).

I-8KE4 ET-7000

RS-232/RS-485

RU-87Pn M-7000 [-7000
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»  Plastic and Metal Housing

The WP-2641M-CE7 comes with the metal casing.

»  Highly Reliable Under Harsh Environment

Our WP-2641M-CE7 operates in a wide range of temperature and humidity.

* Operating Temperature: -25 ~ +75 °C

* Storage Temperature: -40 ~ +80 °C
* Humidity: 10% ~ 90% RH, non-condensing
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1.2. Specifications

The table below summarizes the specifications of the WP-2641M-CE7.

System Software

(0N

Windows CE 7.0 Professional

Framework Support

.Net Compact Framework 3.5

Embedded Service

FTP Server, Web Server

SDK Provided

DIl for Visual Studio.Net 2008

Multilanguage Support

CPU Module

English, German, French, Spanish, Russian, Italian, Korean, Simplified

Chinese, Traditional Chinese

Quad-core Cortex-A9, 1GHz/Core

CPU

DDR3 SDRAM 1GB DDR3
Flash 8 GB eMMC
MRAM 128 KB
FRAM 64 KB

Expansion Flash Memory

microSD socket with one 4 GB microSD card

(support up to 32 GB microSDHC card)

RTC (Real Time Clock)

Provide second, minute, hour, date, day of week, month, year

64-bit Hardware Serial Number

Yes, for software copy protection

Dual Watchdog Timers

Yes

Rotary Switch

Yes (0 to 9)

LED Indicators

VGA & Communication Ports

1 LED for Power, 1 LED for Running, 1 LED for mobile network and 3 LEDs for

user defined

1/0 Expansion
I/O Expansion Bus

Resolution 640 x 480, 800 x 480, 800 x 600, 1024 x 768

Ethernet RJ-45 x 2, 10/100/1000 Base-TX
(Auto-negotiating, Auto MDI/MDI-X, LED indicators)

UsB 2.0 2

comMm1 RS-232 (RxD, TxD, and GND); Non-isolated

COM 2 RS-232 (RxD, TxD, and GND); Non-isolated

CoOM 3 RS-485 (Data+, Data-); 2500 V. isolated

COM 4 RS-485 (Data+, Data-); 2500 Vp isolated

Yes, one optional XV-board

WP-2641M-CE7 (WinCE7 Based) User Manual
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Dimensions (W x H x D) 35mm x 167 mm x 119 mm
Housing Metal
Installation DIN-rail mounting

Environmental

Operating Temperature -25°Cto+75°C

Storage Temperature -40°Cto+80°C
Ambient Relative Humidity 10 % to 90 % RH (non-condensing)
Input Range +12 Vpc to +48 Ve
Consumption 4.8W (0.2 A @ 24 Vy)
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1.3. Overview

WP-2641M-CE7 is equipped with several interfaces and peripherals that can be integrated with external

systems. Here is an overview of the components and its descriptions.

Front View
lm— LED Indicators
~
Eth _.JHI._
ernet Port x 2 .- USB Port x 2
BT

O=——===microSD Card Socket

XV-Board Slot =@
&= Pin Assignment

Item | Description

LED Indicators The WP-2641M-CE7 has 6 LED indicators shown as below.

O O O

RUN PWR

NN,

LED Indicator| Color |

Meaning
RUN Green Power on and OS is running
PWR Red Power is on.
L1 Green
L2 Orange | User programmable LED indicator.
L3 Red
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Ethernet Port

The WP-2641M-CE7 has an Ethernet port that can be

connected to a computer or device via an Ethernet cable.

The Link/Act and 1G LED indicators display the status of
the WP-2641M-CE7. The details are shown as below.

LED Indicator

| State (Color)

ON (Orange)

| Meaning

Link/Act LAN2 16 LinkiAd LAN1 16

Network Speed: 1 G

1G
OFF Network Speed: 10/100 M
ON (Green) The Link is active

Link/Act OFF The Link is inactive

Blinking(Green)

Network activity

USB Port The WP-2641M-CE7 has two USB 2.0 port that allows
support for the USB devices such as mouse, keyboard or
an external USB hard drive.

microSD Card The microSD socketcan be used to restore the WP-2641M-CE7 system and

Socket expand the memory up to 32 GB.

XV-Board Slot

The XV-board slot can be used to support up to one XV-board service.

Pin Assighment Signal Description

1| TxD
2 | RxD COM1 (RS-232)
3 | GND
4 | TxD
5| RxD COM2 (RS-232)
6 | GND
7 | D+
8 | D- COM3 (RS-485)
9 | ISO.GND

10 | D+

11 | D- COM4 (RS-485)

12 | ISO.GND
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Top View

Rotary Switch

VGA Port Power Input and
Frame Ground

Item ‘ Description

VGA Port A VGA connector is a 3-row 15-pin connector that can be used with a variety
of supported VGA resolutions, and the output resolution covers 640x480,
800x480, 800x600, 1024x768.

Rotary Switch Rotary Switch is an operating mode selector switch which provides seven

functions related to the selection of the operating mode.

Power Input and The WP-2641M-CE7 has a terminal with 3pins, there are 2 pins for power

Frame Ground input and a pin for frame ground as follows:

7’ F.G.

PGND =

|— Power Input
PWR =
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1.4. Dimensions

The diagrams below provide the dimensions of the WP-2641M-CE7 to use in defining your enclosure

specifications. Remember to leave room for potential expansion if you are using other components in

your system.

All dimensions are in millimeters.

- 42.0

o0
oo
oQ

=

164.0

oI T
=

154.0

|

Left Side View Front View

Right Side View
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2. Getting Started

This chapter provides a guided tour of the WP-2641M-CE7 installation and configuration that describes
the steps needed to download, install, configure, and run the basic procedures for user working with the

WP-2641M-CE7 for the first time.

Before starting any task, please check the package contents. If any of the following package contents are

missing or damaged, contact your dealer, distributor.

A

Fuoex

miges
WP-2641M-CE7 A microSD card and
WP-2641M-CE7 Quick Start Guide a micro SD/SD adapter
Screw Driver o
(1€016) 2.4 mm Wire Terminal * 16

The following items are included with mobile network expansion card

GSM/GPRS External GPS Active External
Antenna (ANT-421-04) Antenna (ANT-115-03)
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2.1. Mounting the Hardware

The WP-2641M-CE7 has simple rail clips for mounting reliably on a standard 44 mm DIN rail.

Step 1: Mounting WP-2641M-CE7 onto a 44 mm DIN rail
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Step 2: Connecting to a PC, the USB device, and the power supply

i.  Connect the mouse or keyboard to the USB port.

ii. Connect PCto the Ethernet port through an Ethernet switch.

iii. Connect the power supply (+12 to +48 VDC) to PWR and P.GND terminals.
iv. Connect the monitor to the VGA port.

Power Supply +12 to +48 VDC

VGA Port

f
Monitor
USB Port —— ﬁ

LAN Port

USB Mouse/USB Keyboard

Ethernet Switch PC or Laptop
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2.2. Mounting the Expansion Components/Accessories

2.2.1. Mounting the XV-Board

WP-2641M-CE7 has one expansion 1/0 slots to expand the functions. For more detailed information

about the XV-board specifications, please refer to Appendix B. XV-Board Modules.

Step 1: Remove stripped screws and then remove the cover

ﬁ
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Step 2: Hold the XV-board vertically and align the socket, and then carefully press the
XV-board onto the I/O expansion bus

Step 3: Fasten the XV-board using the screws supplied
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Step 4: Close the cover and then fasten the screws

Step 5: Insert the 1/0 terminal
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2.2.2. Inserting the SIM Card

(for Mobile network expansion card had installed)

The SIM card tray is located on the top side of the module. The eject button is on the right side of the

tray door.

Step 1: Remove stripped screws and then remove the cover

Step 2: Insert the SIM card into the Socket

Tips & Warnings

e Make sure to turn the WP-2641M-CE7 off before inserting or removing the SIM card. Do
not bend or scratch the SIM card.
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2.2.3. Installing the antenna

(for Mobile network expansion card had installed)

The Mobile network expansion card has an antenna connector that can be used to connect the 3G/4G
antenna. To install the antenna, just screw the antenna tightly into the connector, and put the antenna in

the purpose place.
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2.3. Configuring the Boot Mode

The WP-2641M-CE7 has several operating modes, which can be selected by a rotary switch.

The table below lists the operation modes available with the WP-2641M-CE7.

Position | Operating Mode ‘

0 Normal mode (Default)
1 Safe mode
2 Debug mode
3 OS update mode by Ethernet
4 Reserve
5 OS update mode by Micro_SD
6 Reserve (OS Development Mode)

7~9 User Mode

The following is a brief introduction of these modes.

Normal Mode (Default mode)

Normal mode is the default mode of operation and the one you will use most of the time. Use this mode

for more tasks and configurations. Programs also are executed in this mode.
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Safe Mode

Safe mode is a trouble shooting. The mode loads the minimum required device drivers and system
services to boot the WP-2641M-CE7.
If you have malicious software or a program caused the WP-2641M-CE7 cannot be boot or run the

normal mode, you can boot in safe mode to solve the problem.

Debug Mode

Debug mode is a special environment in which program debug functions can be used in addition to
normal system functions.

Debug mode is unsupported.

0OS Update Mode

OS update mode is a way used to update OS. For more information on updating the WP-2641M-CE7 OS

image, please refer to section 6.1. OS updates

Reserve — OS Development Mode

The positions 4, 6, of rotary switch are reserved for OS development.

User Mode

The positions 7, 8, 9 of rotary switch are reserved for user’s applications.
When WP-2641M-CE7 is boot with one of these positions, it is boot at normal mode. User’s application

can check the position of the rotary switch position to run at different mode.
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2.4. Using PAC Utility to Manage WinPAC

The PAC Utility is a collection of the WinPAC system tool that allows user quickly and easily manage and
configure the WinPAC.

For more detailed information on PAC Utility applications, please refer to “3.1. PAC Utility”

Step 1: Double-click the PAC Utility on the desktop

Double-click the
PAC Utility shortcutJ

Step 2: Configure IP address (DHCP), FTP Server, Auto Execution files..., etc

[Gemeral I General2 I Display I 1P Config ‘ Netwark |DEVHZE! Infor mation IAutD Execution I Rotary Exd ol I 3
Access | Login

FTP @ Enable () Disable

Allow Anonymols @ Enable () Disahle

Set FTP default download directory to:

[ [ =

Iy Device

Metwork
SetHTTP do| . Systam_disk

windowsiw| - Recycled Apply
Application Data

Iy Recent Docurnents
My Documents
Prograrm Files
Windoas

Cancel | Ok

Step 3: Reboot the WP-2641M-CE7

Save
Save and Reboot
Reboot
Restore Utility Default Settings
Exit
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2.5. Changing the User Interface Language

The Windows CE operating system on the WP-2641M-CE7 comes with several built-in functions.

Step 1: Click Start menu, point to Settings, click Control Panel, and then click Regional Settings
Options

Jj Prograrns ’
'{:‘? Faviorites r
D Documents
- Settings B Control Panel

L Metwiork and Dial-up Connections

- ik

E Taskbar and Start MenL...

\

Regional and Language Settings

Regional Settings User Interface Language I Input Language |

-Your locale

The locale option affects how some programs format numbers, currency,
time and dates.

—rnglich (Lnited States) Customize...
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Step 2: Click User Interface Language tab, choose to your local language, and then click OK

Regional and Language Settings m

| Regional Settings | User Interface Language | Input Language |
-User Interface Language

The option will determine the language used for the menus, dislogs
and alerts,

Erglish (United States EI

French (France)

German (Germarny)

Italian (Ttaly)

PortugLese (Brazil

Soanish (Spain - International Sort)

Step 3: Run the PAC Utility, and then reboot the WinPAC for changes to take effect

Reboot
. Restore Utility Default Settings
PaC Tt Exit
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2.6. Using DCON Utility Pro to Configure 1/0 Modules

DCON Utility Pro enables users easily to configure and manage the I/0O modules via Ethernet or serial
ports (RS-232/RS-485).

Step 1: Double-click the DCON_Utility_Pro on the desktop

8

Double-click the
DCON_Utility Pro
shortcut

v

il

Step 2: Click the

button

ity Pro 2.0.0.0 for CE7 arm(WP5231)

D End Address

L]

|Addr... |Baud Rate |Checks... |Format|5tatus |Description

4
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Step 3: Configure the communication settings

COM Port Option
COM Port Timeaolt
COMO[Backplane] - |200 | ms
COML |
COMD lare] ecksum | Format
COM3 —————J |
COom2
COM4 2 OEst Q081
OK Cancel

Tips & Warnings

Q The COM port settings for expansion I/0O modules are listed below.

L P

COMO[Backplane] «

com1/2/3/4 <€
For more information on these COM port selections, please refer to the

specification of the pin assignments in section 1.3. Overview
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Step 4: Click the B button

uuuuuu End Address

L |

D |Addr‘ |Baud Rate |Checks |Format|Status |Description

1]

Step 5: Click the module name to configure the I/0 module

DCON Utility Pro 2.0.0.0 for CE7 arm({WP5231)

“t=rt Address

El End Address 1

i~ |Baud Rate |Check5...

I Format I Status | Drescription

1|T Disable  N,8,1

XV107 Firmware[0100]

[Modbus RTUS*DI + 8*0d]

DO Status

o v [z [z [J4 [Js

Set Power On | @) Read DO

() Read Power OM Yalue

1 I Set Safe Value (") Read Safe walue

[
COM:O[N,8,1] |

e [z
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2.7. Using Dial-up Networking to Make a GPRS Connection

(for Mobile network expansion card had installed)

The Windows CE dial-up networking component driver can be efficiently used to include support for

transferring data over GPRS modems in WP-2641M-CE7

Step 1: Click Start menu, point to Settings, click Network and Dial up Connections, and then
click Make New Connection

) Programs  *
¢ Favorites  »
"} Documents  *
" [ Contral Panel
2 Run... )

t View Advanced ||)<||1J]r

¥ $x A

: [ [ I ]
Make New PCI- PCL- e

WUpASMISg FETCESB1  FETCESB2

3

Step 2: Type the name of the connection, select the Connection type as the Dialup connection,
and then click Next button

Make New Connection
Type a narme for the connection:

et |
_‘-.-:@I_ IM\; Connection

Select the connection type:
(@) Dial-Up Connection
() Direct Connection
{7 Wirtual Private Metwork (PPTR)
() virtual Private MNetwork (L2TP)
() PPR aver Ethernet [PPPoE]
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Step 3: Select USB Modem as a modem diver in the select a modem option and then click
Configure button

My Connection Properties

Madem |F‘h|:|ne Mumber I

-f;l My Connection

Select a rmodern:

TCP/IP Settings... | Security Settings... |

Step 4: Select 115200 in the Baud Rate option and click then click OK button

Device Properties

Port Settings |Ca|| Ciptions |

r Manual Dial {user supplies dial
strings )

15200

Terminals

[ Use terminal window Barity IND”E E
before dialing Stop Bits II—E

r Lise terminal window after

dialing Flowe Control IHardware :I

Step 5: Select Call Options tab, enter the modem dialing settings in the commands field, and
then click OK button

The modem dialing settings depends on each of the telecom company. For example, the
settings provided by Telecom Company in Taiwan is

+CGDCONT=1,”IP”,”INTERNET”
and a Telecom Company in China is

+CGDCONT=1,”IP”,”CMNET”

Device Properties m

Call Setup
Cancel the call if not connected within 120 seconds
Wait for dial tone before dialing

Wait for credit card tone |0 seconds

Extra Sz . (special rmodem cornrmands may be inserted v =sJial string)
I+CGDCONT= 1,"TP","INTERNET"
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Step 6: Select Phone Number tab, enter the phone number settings in the Phone number
option, and then click OK button

The phone number settings should fit the Telecom Company’s setting. For example, the
following setting is for Telecom Company in Taiwan.

My Connection Properties m

Phane Mumber
é:l My Connection

Country fregion code:; |1

E—

Area code: T

Phone nurmber: I*QQ***l#

[ Force long distance
[ Force local

Step 7: Double-click the new connection that you have created, and enter the User name and
Password, and then Click Connect button

File Edit -~ anced || X e oo |- EE|

o 3 i
Make M{v y S LaM1
Connectic
Dial-Up Connection
S A
Liser Mame: |guest s kA g
Password: J N
Darnar, | il Froperties... |
B SRR | Connect I ‘ Cancel |
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Step 8: Wait for the connection to be established

U200 Status
-‘f}l Connected

Hide this rnessage:

Disconnect

Tips & Warnings

e If the connection fails, as shown below, please repeat the instructions to view the settings.

Remote Networking

;
i ! E The port is not available: another program may be using it.
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3. Tools and Tasks

This chapter provides a brief introduction of the WP-2641M-CE7 service tools and its benefits.

There are several tools and utilities built-in and designed for use with WP-2641M-CE7. Some of these are
pre-installed on WP-2641M-CE7 and can work directly on WP-2641M-CE7, and some of these are
supporting tools and can help you to manage the WP-2641M-CE7 remotely on a PC.

The following tools are pre-installed on WP-2641M-CE7 and can work directly on WP-2641M-CE7 that

can be found by downloading the latest version from ICP DAS web site.

http://ftp.icpdas.com/pub/cd/winpac_imx6/wp-2641/system_disk/tools/

- .
- T
B oo mste-too
T
— T
— T
T
B crarocon
T
T

WP-2641M-CE7 (WinCE7 Based) User Manual v1.0.1 Page: 36



The following tools are supporting tools for remote managing the WP-2641M-CE7 used on PC that can

be found by downloading the latest version from ICP DAS web site.

http://ftp.icpdas.com/pub/cd/winpac_imx6/wp-2641/pc_tools/
E— Eshell
B Remote_display_application

Tl Tools
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3.1. PAC Utility

PAC Utility is a collection of software applications that enable management and configuration of WinPAC

system and features.

PAC Utility [1.2.0.5] ! E

| Digplay I IP Canfig I Metwark I Device Information I ALta Execution IRDtary Execution |

Witelcome fo use PAC Utility
This ool will help you easy to
Lise PAC CE series,

PAC Utility

Task Bar setting:
[ Auto Hide

[ &lways On Top

HIVE Registry:
@ Auto Save To Flash (Default

(" Maunal Save To Flash

Backplane Battery [[] Enable sutorun in plugging USE Disk
Batteryl : Battery2 :
Configure the synchronization with 3 time server | Configure

The PAC Utility includes the following menu bars and property tabs. All of these functions will be

explained later.

Menu bar | Property Tab ‘
* File * General
* Help * Display

* |P Config

* Network

* Device Information
¢ Auto Execution

* Rotary Execution
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3.1.1. Menu Bar - File

Save
Save and Reboot

Restore Utility Default Settings

Exit
The menus use to | How to use
Reboot Restarts the WinPAC
Restore Default Settings Restore the settings of WinPAC to its default.
Exit Exits the PAC Utility.
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3.1.2. Menu Bar — Help

About PAC Utility

PAC Utility

PAC Utility
Yersion: 1.2.0.5

Copy Right (c) 2005, ICFDAS Co., LTD.
All Rights Reserved. PAC Utility and the
PaC Utility logos are tradermarks of
ICPDAS,

Pac (lindows CE; en-US)

The menus use to How to use

About Displays a dialog box with information about PAC Utility,

including the current version and copyright information.
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3.1.3. Property Tab - General

The General tab provides functions to configure the task bar, check the status of the battery..., etc.

PAC Utility [1.2.0.6]

File Help

Backplane Battery
Batteryl

Configure the synchronization with a time server

Welcome to use PAC Utility
This ool will help you easy o
use PAC CE series.

Taszk Bar setting:
[ &uta Hide
[ &bways On Top

HIVE Reqistry:
@' i e To Flash (Default)
O M NS e T : = s |

[] Enable sutorun in plugging USE Disk
[] Enable &utorun in plugging Micro SO

| Configure |

The tab use to How to use

Lock or Auto-Hide the taskbar

Auto-Hide:

Select the Auto Hide check box.
Lock:

Select the Always On Top check box.

Auto save or manual save to flash

By default, these options are unavailable.

Auto save to flash:

This option is checked by default.

Any changes made to the WP-2641M-CE7 will be saved and
only take effect after the WP-2641M-CE7 reboots.

Manual save to flash:

This option is useless.

Check the status of the battery

See the Batteryl1 field that displays the display resolution.

Automatic synchronization of

system time

Refer to the Appendix A.2. How to Automatically Synchronize

WinPAC Clock with an Internet Time Server.
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3.1.4. Property Tab — Display

The Display tab provides functions to configure the monitor settings.

PAC Utility [1.2.0.6] ! E

Screen resolution: 800 x 600 Screen refresh rate:
Less U More 70 EI

800 by 600 pixels

The tab use to How to use
Adjust the screen Move the slider to the left to decrease the resolution or move the slider
resolution to the right to increase the resolution, and then click the Apply button.
Change the screen Select the desired refresh rate from the Screen refresh rate drop-down
refresh rate list, and then click the Apply button.
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3.1.5. Property Tab - IP Config

The IP Config tab provides functions to configure either DHCP (Roaming) or manually configured (Static)
network settings and to monitor the MAC address. Generally, DHCP is the default settings, but if you

don’t have a DHCP server, you must configure the network settings by using manual configuration.

PAC Utility [1.2.0.6] _I0

LANM 1:

MAC Address: 7B8-C5-ES-88-96-8C
(@ Use DHCP to get IP address
() assign IP address

IF Address: |1E|.1.EI.EIE|

Mask: |255.255.EI.EI

Gateway:  [10.1.0.254

DS Server: |1D.IZI.IZI.3

[ Reboot far changes to take effective

The tab use to How to use

Use DHCP to get IP address:

Select the Use DHCP to get IP address option, and then click the Apply
Set the network
button.
settings
Assign an IP address:

Select the Assign IP address option, and then click the Apply button.
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3.1.6. Property Tab — Network

The Network tab comprises three tabs — Access, Login and File Server Settings.

Access

The Access tab provides functions to enable/disable the FTP access, enable/disable anonymous FTP

access, and configure the FTP and HTTP directory path.

PAC Utility [1.2.0.6] ! E

[General Display IIF' Config ‘ Metwork | Device Information Iﬁub:u Execution IRDtary Execution |

Ef-‘tEEESS Login IFiIe Server Settings |

FTP

Allow snonymous @ Enable (") Disahle

Set FTF default download directory to:

(@ Enzhle {) Disahle

WTemp || || Apply
Set HTTF docurment root directory to:
v indoweswrastiarwnesib || || Apply

Enable or disable

the FTP access

Enable:
Select the Enable check box in the FTP field, and then click the Apply button.

Disable:
Select the Disable check box in the FTP field, and then click the Apply button.

Enable or disable
anonymous FTP

access

Enable:
Select the Enable check box in the Allow Anonymous field, and then click the
Apply button.

Disable:
Select the Disable check box in the Allow Anonymous field, and then click the

Apply button.

WP-2641M-CE7 (WinCE7 Based) User Manual v1.0.1 Page: 44



The tab use to How to use

Set the FTP Enter a new path in the Set FTP default download directory to: field, and then
directory path click the Apply button.

Set the HTTP Enter a new path in the Set HTTP document root directory to: field, and then
directory path click the Apply button.

Login

The Login tab provides functions to maintain the FTP accounts.

PAC Utility [1.2.0.6]

File Help

[General IDispIay IIF' Config | Metwork | Device Information Iﬁub:u Execution I Rotary Execution |

[Access | Login | File Server Settings |

Lser Name Password

licrDas | . | [Add || Delete
Liser narme I Password I
ICPDAS ok

The tab use to How to use
Maintain the FTP Refer to the Appendix C.1 How to add a user account to remote login the
accounts WinPAC from PC.
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File Server Settings

The File Server Settings tab provides functions to set the SMB server.

PAC Utility [1.2.0.6] ! E

[General I Display IIP Config | Metwork | Device Infar mation Iﬁub:u Execution IRDtary Execution |

ACCESS I Lagin | File Server Settings |

fou can create a networked file server and enables clients 1o store and
retrieve files, and makes use of the Internet for communication between
client devices and other shared equipment.

¥ y Settings
= | B Share Files System Settings [l

Device Mame (Each device need setting
a different device name)

|C|:| rpact |

The path to the folder to be shared

e ]

Configure the file server to use Lalx as
the network adapter

|cPswacy v

Enable all authentication on the file
server, The file server will not be
accessible o all users on the

network and the "admin" as the
user to be allowed access o the
file server

Set

Help

| Thewbuseto | Howtouse

‘ Set the SMB server ‘ Click the Settings button to set the SMB server path. ‘
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3.1.7. Property Tab — Device Information

The Device Information tab provides functions to monitor necessary system information of the WinPAC.

The information is the most important note of version control for upgrading system.

PAC Utility [1.2.0.6]

File Help

General ] Display ] IF Config ] Metwork | Device Informatian l AL Execution | Rotary Execution ]

slott: [ ] CPU Type: [wPs23x |
Slotz: [ ] Serial Number: |p1-s8-2c-1F-16-00-0020 |
Slat 3 I:I Backplane Version: |fo-‘~ |
Slot 4 |:| CPU Version: [z |
Slot 5 |:| 0S version: [1005 |
Sote: [ ] Ebootversion: 52525 |
Sot7: [ ] METCF Version: [3.5.7338.00 |

SOL CE ersion: |2.5.8154.0 |

PACSDK Version: 4321 |
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3.1.8. Property Tab — Auto Execution

The Auto Execution tab provides functions to configure programs running at WinPAC startup, it allows

users to configure ten execute files at most.

Tips & Warnings

The specific extensions are .exe and .bat, and they are executed in order of program 1,
program 2, etc.

PAC Utility [1.2.0.6]

[General IDiSpIay IIF' Config I Metwork IDevice Information | AUt Execution |Rc|tarﬁ,r Execution |

Program 1: |‘-53rstem_Disk1TDDIsWu:epw_rethe.exe || Browse |

Program 2: |Eystem_Diak\TDDIs\FAC_Utilit:.r\FAC_Utilit:.r. || Browse |

Prograrm 3. | | | Browse |
Prograrm 4: | | | Browse I
At m;at 10 p;ugr:jms FrogramS: | || Browse |
can be specifie .
execute automatically Fie 2RI ) | | | Browse |
at systerm startup, Program 7: | | | ym— I
Frograrm 8: | | | Browse |
Prograrm 9: | | | Browse I
Programl0; | | | Browse I

The tab use to How to use
Configure programs Click the Browse button to select the execute file which you want, and
running at startup then click the Apply button.
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3.1.9. Property Tab — Rotary Execution

The Rotary Execution tab provides functions to configure programs running at WinPAC startup in one of

the user defined mode, it allows users to configure ten execute files at most.

PAC Utility [1.2.0.6] M (=}

[ General IDiSpIay I IP Config I Metwark I Device Infarmation I ALto Execution | Rotary Execution |

Rotary Switch 0 ‘Nnrmal Mods | | Erowse |
Rotary Switch 1 |Safe Mode | CErowse |
Rotary Switch 2: ‘Debug Aode | | Browse |
Raotary Switch 3: ‘OS update mode by Ethernet | | Browse |
Rotary Switch 4: ‘Reserued | Bronwse |
Rotary Switch 5: ‘OS update made by Micra_SD | | Browse |
Rotary Switch &6 ‘Regerued | | Briomse I
Rotary Switch 7 ‘ | | Browse |
Rotary Switch 2: ‘ | | Browse |

Rotary Switch 9; | | _Browse |

The tab use to How to use

Configure programs running at startup | Click the Browse button to select the execute file which you

in one of the user defined mode want, and then click the Apply button.
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3.2. DCON Utility Pro

DCON Utility Pro enables users easily to configure and manage the I/0O modules via Ethernet or serial

ports (RS-232/RS-485).

For more detailed information on how to use DCON Utility Pro to configure I/O modules, please refer to

“2.4. Using DCON Utility Pro to Configure 1/0 Modules”

DCON Utility Pro 2.0.0.0 for CE7 arm{WP5231)

Start Address EI End Address

I |deu:lr... |Baud Rate |Chet:k5... |Format|5tatua |De5cription
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3.3. TaskMgr

The TaskMgr is a Windows CE application, which provides real time info on all processes and threads

including System threads, similar in appearance to the Windows Task Manager.

Windows CE Task Manager

Performance IPI‘DCESSES Ij-app]jcaticu 1 n
100

wWindows CE Task Manager

Lpplicatio II u

Processes

Irnage Mam... | Thres... | Ilem. | &
TaskIvlanager.e -
_remnte exe wWindows CE Task Manager
gervicesd exe hpplications | Disk Net
Usage 2% explorer.exe
Gwellzer e Task |
—_—| | udeviceee (%]
udenvice exe YV Virtual CE
HE B¥E
|
|
d | B
Close Swritch
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3.4. VCEP

ICPDAS VCEP is designed for managing your WinPAC anywhere. No matter where you are, ICPDAS VCEP

provides a convenient environment on the Desktop PC and lets you control your WinPAC remotely.

ICPDAS VCEP is composed of two main components: The “Server” which runs on WinPAC and the ‘Client’
which runs on a Desktop PC.

Once a connection is established between the client and server (initiated by the client), the client will
periodically send requests for screen updates and send mouse/key click information to the server to
simulate.

Each video frame is inter-compressed against the previous frame and then intra-compressed with a

modified LZW scheme to minimize the amount of data transmitted from server to client.

For more detailed information on VCEP application, please refer to

http://ftp.icpdas.com.tw/pub/cd/winpac/napdos/wp-8x4x ce50/pc tools/vcep 5.0.0.0/
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3.5. Remote_Display

The "Remote Display" allows WinPAC to be controlled and monitored from a remote location. This tool is
composed of two parts, a client and a server. The server is a program named cerdisp.exe running on

WIinPAC. The client is a PC-based program named cerhost.exe running on the PC.
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3.6. SendToCOM

The SendToCOM uses the serial port to communicate with expansion module. To use the SendToCOM,
you can send data to expansion module through the serial port, and receive data from other device

through the serial port.

For more information about these commands for communicating with expansion module, please refer
to:

http://www.icpdas.com/root/product/solutions/remote io/rs-485/i-8k i-87k/i-8k i-87k selection.html#
b

ICPDAS Send to COM V1.0.4 2011223
Conneckion Skatus
M Port Baudrate Draka Bit Pariky Stop Bit Slot
|COM2 | |115an | IE :| ||:|-Nc.ne Patity :| |1 :I | :|
Endstringwith @ none (PR (R (O cRIF OLWF [string | B4 +cre

Commands Responses O Y @ J -
Current Packet Size (bytes) |p Current Packet Size (bytes) Auka send Internal ims)  (5on
Total Packet Evtes o Total Packet Bykes o | - | | Stop | Set
Packet Quantity send ] Packet Quantity received |0 Start Time |Start Tims

ﬂl Stop Time  |Stop Time

Clear
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3.7. RegEdit

The RegEdit provides a hierarchical representation of the registry on a target computer, similar in
appearance to the Windows Registry Editor. The standard registry roots are represented; you can add
keys beneath a root to point to existing registry keys, or you can add your own keys. Values can be
changed for existing keys, or added for new keys, and default keys can be specified. For more

information, see Registry Settings Management in Deployment.

Registry Editor Version 1.2.2 !

EY_C _ROO Narme | Type | Data |

B HREY_CURREMT _USER

B HKEY_LOCAL_MACHINE
- HKEY_USERS
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3.8. 1SQLW35

The "1SQLW35" is a Windows Embedded Compact 7 functionality that implements SQL Server Compact
3.5 Query.

soL | @ arid Mates

Tools 501 | A X
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3.9. INotepad

The INotepad is a common text-only editor. The resulting files have no format tags or styles.

INotepad ! E
File Edit Format Help

s
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4. Your First WinPAC Program

This chapter provides a guided tour that describes the steps needed to set-up a development

environment, download, install, configure for user programming with the WP-2641M-CE7.

Before writing your first program, ensure that you have the necessary development tool and the

corresponding WinPAC SDKs are installed on your system.

Development Tools

WP-2641M-CE7 are Windows CE-based units. Windows CE is a mature embedded operating system

which supports rapid development.

The table below lists the supported development tools and development languages to develop

WP-2641M-CE7 applications.

Languages \VIE]
Visual C# Visual C++

Development Tools Basic.Net

Any versions except

Visual Studio 2005 . - - -
Professional

or earlier
Professional - - -
Any versions except
Visual Studio 2008 Professional

Professional \' '} \'

Any versions except

Visual Studio 2012 . - - -
Professional

or later

Professional - - -
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4.1. Preparing the Development Tools

WP-2641M-CE7 is a Windows CE-based unit. Windows CE is a mature embedded operating system which
supports rapid development. The standard development tool is list as follows which is highly integrated,

with comprehensive support for developing applications of Windows CE-based WP-2641M-CE7.

>  Visual Studio 2008

Microsoft* ‘ ;

Visual Studio 2008

WP-2641M-CE7 has .NET Compact Framework 3.5 installed. Visual Studio 2008 takes full advantage of
the .NET Compact Framework, which uses public Internet standards to enable integration with new
and existing applications running on any platform. Supported languages include Visual C#, Visual C++

and Visual Basic .NET.

Installation Steps:

1. Visual Studio 2008 Professional
Purchase from MSDN subscription

Microsoft DreamSpark: https://www.dreamspark.com/Product/Product.aspx?productid=1

2. Visual Studio 2008 Service Pack 1

http://www.microsoft.com/en-us/download/details.aspx?id=10986

3. Visual Studio 2008 update for Windows Embedded Compact 7

http://www.microsoft.com/en-us/download/confirmation.aspx?id=11935

4. Windows Embedded Compact 7 ATL Update for Visual Studio 2008 SP1

http://support.microsoft.com/kb/2468183/en-us
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4.2. Installing WP-2641M-CE7 SDK

The WiInPAC SDK is a Software Development Kit (SDK) that contains C header files, C libraries and

documents.

Step 1: Get the latest version of the installation package file and execute it

The installation program for the latest version of the WinPAC Platform SDKs can be
obtained from:
http://ftp.icpdas.com/pub/cd/winpac_imx6/wp-2641/sdk/platformsdk/

File name: File name: GuruCE_imx6_SDK_CE7_yyyymmdd.msi
yyyymmdd: platform sdk released date

Step 2: Follow the prompts until the installation is complete

Step 3: Execute the “VisualStudioDeviceWindowsEmbeddedCompact7.msi”

The VisualStudioDeviceWindowsEmbeddedCompact7.msi can be obtained from:
http://ftp.icpdas.com/pub/cd/winpac _imx6/wp-2641/sdk/platformsdk/
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Step 4: Execute any VS2008 C++ project include the GuruCE_imx6_SDK (ARMv4l) platform and
the click the “Tools”->"Options...”

Tools | Test Window  Help

;-1 Attach to Process... Ctl+AlHP
3;,;.) Device Becurity Manager. ..

.g];. Connect to Dewice ..

Ej? Device Emmlator Manager. ..

q-:"_h. Connect 1o Databaze..

qg Connect o Berver...

) Code Snippets Manager..  CtlE, Ctl+B
Chooss Toolboy Ttems. ..
Add-in Manager. ..
Macmoz 3

Find More Extensdons...

Create GUID
Dotfuzeator Commmndty Edition
Error Lookup

A TLFC Trace Tool

SO

Visnal Stodio 2005 Command Prompt
=B WCF Service Contignratinn Editor

External Tools...

Linport and Export Sethings.
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Step 5: Click the “Projects and Solutions”->"VC++ Directories” and then select the
“GuruCE_imx6_SDK (ARMv4l)” ~ “Include files” at “Platform:” and “Show directories
for:” item

Platform: Show directories for:
; ‘G'JL'JCE M6 SDK (ARMv4I) v | Include files v

B ul:l .nnd Run ﬂﬁﬂﬂﬂ

VB Defaults $(VCInstallDir)ce\include

VC++ Directories b(\ ClnstallDirice\arlmfciinclude

VC++ Project Settings C:\Program Files\Windows CE Tools\SDEs\GuruCE iMX6 SDE\include\ARMv4T
Source Control C:\P:'og:am Files\Windows CE Tools\SDKs\GuruCE iMX6 SDE\include

T $(VSInstallDir)SmartDevices\SDEKASQL ServerMobilew2.0

Text Editor
w-Database Tools
w D“L i

® HT_\[L Dsu,__n\,:
Office Tools
Test Tools
Text Templating Include Directorie
A eme Barmre Tlact amer nclu irectories
zzlcni;; F]S;;lzgdltn“ Path to use when searching for include filss while building 2 VC++ project.
= Corresponds to environment variable INCLUDE.

< |

v

OK ][ Cancel

Step 6: Add the path “$(VCinstallDir)ce7\include” and “$S(VClinstallDir)ce7\atimfc\include” and
then click the OK button.

Platform: Show directories for:

GuruCE iMX6 SDK (ARMv4D) v RS v
ek x| +] ]

$(VClInstallDir)ceinclude

$(VClInstallDir)ce\atlmfchinclude

C:\Program Files\Windows CE Tools\SDKs\GuruCE iMX6 SDK\include\ARMv4I

C: P:D"";ﬂ Files\Windows CE Tools\SDKs\GuruCE iMX6 SDKinclude

SV SIns‘c_llDl N8SmartDevices\SDK\SQL Server\Mobile\w3.0

Tips & Warnings

e The path “S(VClnstallDir)ce7\include” and “S(VClInstallDir)ce7\atimfc\include” must be on
the top of box.
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4.3. First WinPAC Program in VB.NET

The best way to learn programming with WinPAC is to actually create a WinPAC program.
The example below demonstrates how to create a demo program running on WinPAC with VB.NET.
To create a demo program with VB.NET that includes the following main steps:

1. Create a new project

2. Specify the path of the PAC reference
3. Add the control to the form

4. Add the event handling for the control
5. Upload the application to WinPAC

6. Execute the application on WinPAC

All main steps will be described in the following subsection.

In this tutorial, we will assume that you have installed WP-2641M-CE7 SDK on PC and used the Visual
Studio 2008 for application development.
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4.3.1. Create a New Project

The Visual VB.net project template is a composite control that you use in this example creates a new

project with this user control.

Step 1: Run the Visual Studio 2008

Visual Studio 2008

a0

Step 2: On the File menu, point to New, and then click Project

_Ei]e Edit Wiew Tools Test Window Help

New » | 5] Project.. Chrl+Shift+N

Open » | @ WebSite.. Shift+ ALt+N

Close ] Eie.. Chl+N
Project From Existing Code...

@ Save Al Ctl+Shaft+S

Recent Files >
Recent Projects 4
Exit
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Step 3: In the Project types pane, expand Visual Basic, and then click Smart Device

Step 4: In the Templates pane, click Smart Device

Step 5: Type a name in the Name field, and then click OK

Here we will enter the name “SDKInformation” and a different location for the project if

you wish

New Project E]

(NETFramework 35 ||

Project types: Templates:
[=)- Vizual Basic Yizval Studio installed templates
W indoves
Web Jfel#mart Device Project
Smart Device
Office
Databaze Mmpl&tes
Reporting
Test
WCE
Workflow
Vimmal C#
Viznal C++
Other Project Tvpes
Test Projects

i mearch Onling Templates...

|£L project for Bmart Device applications. Choose target platform, Framework version, and template in the next dialog box. |

Narme: | SDEInformation |
Location: |C:'\Documents and SethngshWindowsby DocomentsWh_Windowsd My Documents w | Browss...
Solution Name: |SDKIn.fDnmI:iJ:nn | Create divectory for solution

[ oK [ Comcel |

Tips & Warnings

A The WCE7 only support .NET Compact Framework Version 3.5, if your application uses .NET
Compact Framework Version 2.0 there is no guarantee that the program will function

correctly.
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Step 6: In the Target platform item, choose Windows CE

Step 7: in the .NET Compact Formwork version item, choose .NET Compact Framework

Version 3.5

Step 8: in the Templates pane, choose Device Application, and then click Next

Add New Smart Device Project - SDEInformation

Target platform: | Windows CE b |
HET Compact Framework version: | NET Compact Framework Version 3.5 b |
Templates:
= = ; 1EE
Al = [ e a®e ==
g = Description:
Class Library  Console Control  Empty Project 4 project for creating a NET
Lpplication Libwary Compact Framework 3.5 foms
application for Windows CE
Flatform

Diowenload additonal emnulator images and smait device SDEs.

OK || Concel
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4.3.2. Specify the Path of PAC Reference

The PAC SDK provides a complete solution to integrate with WP-2641M-CE7 and it’s compatible with

Visual C#, Visual Basic .net and C++. In order to use a component in your application, you must first add
a reference to it.

Stepl: Get the PACNET.dIl and copy it to the project folder

The PACNET.dIl can be obtained from the link below that has been provided by
downloading the latest version from ICP DAS web site.

http://ftp.icpdas.com/pub/cd/winpac imx6/WP-2641/sdk/pacnet/

e N FECHETL
O N Ry
w | FLCNET

.............................
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Step 2: In Solution Explorer, right-click the References node, and then click Add Reference...

Solntion Explorer - MyPorject

Rl2FEEDA

(o Solution MyPorject' (1 project)

Eebuild
Deplay
Clean
Add 2
Add Reference. .,
Add Web Reference, .,
&% Wiew Class Disgram
Setaz Startllp Project
Diebug k

& Cut

7 Remove
Rename
ndoad Project

d‘ Qpen Folder in Windows Explorer
Change Target Platfonm...

F_j,] Properties

'LEJRESDUICE Tiew |¢g Solution Explorer [ Class View
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Step 3: Select Browse tab and add the PACNET.dII

Add Reference

| NET | Projects ’ Browse |Recent |
Location: | [ SDEInformsation VI 3 2 E®E-
)b
() My Project
()obi
EYPACNET.A0
Hame: PACNET 4l v
File types: JCompom:nt Files (*d1;* tlb;* olb;* ocx;* exe) w ’
[ o || Cawel |
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4.3.3. Add the Control to the Form

You can drag various controls from the Toolbox onto the form. These controls are not really "live"; they

are just images that are convenient to move around on the form into a precise location.
After you add a control to your form, you can use the Properties window to set its properties, such as

background color and default text. The values that you specify in the Properties window are the initial

values that will be assigned to that property when the control is created at run time.

Step 1: From the Toolbox, drag a Button control onto the form

Toolbox
= All Device Controls ~
R Pointer

247 BindingSource
l Button | | ‘
CheckBox

] ion* ' Forml.vb [Design]* =7
=% ComboBox SDKInformation orml.vb [Design]*  Start Page

1 DataGrid

29| DataSet

T Date TimePicker

[ DomainUpDown

<3 H¥crollBar

=7l ImageList =
% Server Explorer |35 Toolbox |

= mainMenul
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Step 2: Right-click the Button control, and then click Properties

SDKInformation* ' Forml.vb [Design]*  Start Page

o IR

qd
X

[Z] View Code

J; Bring to Front
41 Send to Back

@ Lock Controls
Select Forml'
Cut

Copy

w9

Delete >

g X {

= mainMenul Properties

Step 3: In the Properties window, type Check the SDK version, and press ENTER to set the Text
property

Buttonl Svstem. Windows Forms Button -
ENNEE
BackColor [] Control
Font Tahoma, 10pt
ForeColor - ControlText
Check the SDK Version v,
g 7
ContextMenu (none) >
Text
The text contained in the control.
'_73 Class View ijEms, [
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4.3.4. Add the Event Handling for the Control

You have finished the design stage of your application and are at the point when you can start adding

some code to provide the program's functionality.

SDKInformation* ~ Forml.vb [Design]* ¥ X

~
6
. o 0
Step 1: Double-click the button on the form o Check the SDK Version
o = )
v
< >
= mainMenul

Step 2: Inserting the following code

Dim data(30) As Byte
PACNET.Sys.GetSDKVersion(data)
MessageBox.Show(PACNET.MISC.WideString(data))

oPublic Clazs Forml

Private 3ub Buttonl_Click(BvVal sender As Svstem_Object, BvVal e Bz System Eventdrgs) Handles Buttonl .Click
Dim dataf30) A= Byie
PACHET Evztem . GetilEVersionidatal
MessageBox Show(PACNET MISC WideString(datal)
End Zub
End Clazs

Tips & Warnings

A The “PACNET” of “using PACNET” is case- sensitive.
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4.3.5. Upload the Application to WinPAC

WinPAC supports FTP server service. You can upload files to WinPAC or download files from a public FTP

server.

Step 1: On the Build menu, click Build SDKInformation

File Edit Yiew Project Debug Tools Test Window Help
" Build Solution  Ctl+Shift+B

| Rebuild Solution

Deploy Solution

Clean Solution

Build SDKInformation

Rebuild SDKInformation

Deploy SDKInformation

Clean SDKInformation

Project Only »

Batch Build...

: Configuration Manager...

|2 Compile Ctr4F7
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Step 2: Open the browser and type the IP address of WinPAC

Step 3: Upload the SDKInformation.exe application and the corresponding PACSDK.dIl and
PACNET.dII files to WinPAC

Tips & Warnings

executing these application on WinPAC, the corresponding PACSDK.dIl and PACNET.dIl must
be in the same directory as the .exe file.

2 For applications programming in C# and VB.net with .net compact framework, when

File Edit View Go Favorites |||]][

[I]ﬁgdress | vTernp

@ & O

PACHET.dI - PacSDK.dI E0ikinformati
ioonexe
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4.3.6. Execute the Application on WinPAC

After uploading the application to WinPAC, you can just double-click it on WinPAC to execute it.

™

EhKInformat:
L ONeRe
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4.4. First WinPAC Program in Visual C#

The best way to learn programming with WinPAC is to actually create a WinPAC program.

The example below demonstrates how to create a demo program running on WinPAC with CH.

To create a demo program with C# that includes the following main steps:

1. Create a new project

2. Specify the path of the PAC reference
3. Add the control to the form

4. Add the event handling for the control
5. Upload the application to WinPAC

6. Execute the application on WinPAC

All main steps will be described in the following subsection.
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4.4.1. Create a New Project

The C# project template is a composite control that you use in this example creates a new project with

this user control.

Step 1: Run the Visual Studio 2008

Visual Studio 2008

a0

Step 2: On the File menu, point to New, and then click Project

_Ei]e Edit Wiew Tools Test Window Help

New » | 5] Project.. Chrl+Shift+N

Open » | @ WebSite.. Shift+ ALt+N

Close ] Eie.. Chl+N
Project From Existing Code...

@ Save Al Ctl+Shaft+S

Recent Files >
Recent Projects 4
Exit
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Step 3: In the Project types pane, expand Visual C#, and then click Smart Device

Step 4: In the Templates pane, click Smart Device

Step 5: Type a name in the Name field, and then click OK

Here we will enter the name “SDKInformation” and a different location for the project if

you wish.

New Froject

Fioject types: Templates: NET Framework 3.5 W | “;”

Vimal Basic ¥Yisual Studio installed templates
[=- Visual C# B
Windows “.ESmart Device Froject
Web
Simart Device
Difice My Templates
Databasze
Reporting
Test
WCF
Workflow
Vizual C++
Cither Project Types
Test Projects

o Search Online Templates. .

|P. project for Smeart Device applications. Chooss terget platform, Framework verson, sud template in the nexd dislog box |

Hamme: | SDEInfornmation |
Location: | CADocuments and Settings\Windows\by Documents\ Wi Windowsd My Documents LY | Browss...
Solution Name: | SDEInfonmation | Create directory for solution

[ 0K ][ Camel |

WP-2641M-CE7 (WinCE7 Based) User Manual v1.0.1 Page: 78



Step 6: In the Target platform item, choose Windows CE

Step 7: in the .NET Compact Formwork version item, choose .NET Compact Framework
Version 3.5

Step 8: in the Templates pane, choose Device Application, and then click Next

Add New Smart Device Froject - SDEInformation

Target platform: | Windows CE b |
MNET Compact Framewark version: | NET Compact Framework Version 3.5 e |
Templates:
- ! 2]
NG R
b Lgi'. - b Dlescription:
Class Librery  Console Contml  Empty Project L project for creating a NET
Lpplication Library Compact Framewnork 35 forms
application for Windows CE
Platform

Download additonal emulator imases and smart device SDEs.

[ oK [ Cancel

Tips & Warnings

A The WCE7 only support .NET Compact Framework Version 3.5, if your application uses .NET
Compact Framework Version 2.0 there is no guarantee that the program will function

correctly.
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4.4.2. Specify the Path of PAC Reference

The PAC SDK provides a complete solution to integrate with WP-2641M-CE7 and it’s compatible with

Visual C#, Visual Basic .net and C++. In order to use a component in your application, you must first add
a reference to it.

Stepl: Get the PACNET.dIl and copy it to the project folder

The PACNET.dIl can be obtained from the link below that has been provided by
downloading the latest version from ICP DAS web site.

http://ftp.icpdas.com/pub/cd/winpac imx6/WP-2641/sdk/pacnet/

PACHNET ALl
n 0.7.24409] ¢
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Step 2: In Solution Explorer, right-click the References node, and then click Add Reference...

Solution Explorer - SDKInformation

o »FE EIE&L

" Solution SDKInformation’ (1 project)
= 4 ATy ——_
@ =4 Proper] (72 Buid
@ (2 Refere Rebuild

= 2] Forml
%) Fo Deploy
%) Fo Clean
&) Pog Add 3
Add Reference. ..

Add Web Reference...
&3 Yiew Class Diagram

Set as StartUp Project

Debug »
& Cu

X £

Remove

Rename

Unload Project

(Y Open Folder in Windows Explorer
Change Target Platform...

‘.5 Properties

= Resource View | QSdluﬁon Explorer ,ch Toss View |
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Step 3: Select Browse tab and add the PACNET.dII

Add Reference

| NET | Projects | Browse |Recent I

Loeation: ‘@SDKlnfonmﬁun Vi % 5 Rk FEF b
) bin

() My Project

(=) obi

PACNET.d

Hame: PACNET.AN v

File types: ‘Componmt Files (*d1;* flb;* olb;* ocx;* exe) W |
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4.4.3. Add the Control to the Form

You can drag various controls from the Toolbox onto the form. These controls are not really "live"; they

are just images that are convenient to move around on the form into a precise location.

After you add a control to your form, you can use the Properties window to set its properties, such as
background color and default text. The values that you specify in the Properties window are the initial

values that will be assigned to that property when the control is created at run time.

Step 1: From the Toolbox, drag a Button control onto the form

= All Device Controls ~
R Pointer

iij Bindinglource

] Button ‘
CheckBox ;
=% ComboBox ” Forml cs [Design]*  Start Page | Object Browser v X
RE| Contextienn
1 DataGuid

27| DataSet

7 Date TimePicker
[ DomainUpDown
<3 H¥crollBar

=) TmageList v v

% Server Explorer |35 Toolbox |

= mainMenul
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Step 2: Right-click the Button control, and then click Properties

Form1 .cs [Design]*  Start Page | Object Browser v X

View Code
Bring to Front
41 Send to Back

@ Lock Controls
Select Forml'
Cut

Copy

£ o

X Delete
< ' Properties >

= mainMenul

Step 3: In the Properties window, type Check the SDK version, and press ENTER to set the Text

property
Buttonl Svstem. Windows Forms Button -
2L [5];
E D ATANCE Ar
BackColor [] Control
Font Tahoma, 10pt
ForeColor - ControlText
Check the SDK Version v,
=] Y101
ContextMenu (none) >
Text
The text contained in the control.
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4.4.4. Add the Event Handling for the Control

You have finished the design stage of your application and are at the point when you can start adding

some code to provide the program's functionality.

Step 1: Double-click the button on the form

Forml .cs [Design]* - Start Page 5
A
X

g 0 :

0 Check the SDK Version {

s LT L)
v

< >

= mainMenul

Step 2: Inserting the following code

byte [Jdata = new byte[30];
PACNET.Sys.GetSDKVersion(data);
MessageBox.Show(PACNET.MISC.WideString(data));

mnamespace slKInformation

{
puhlic partial class Forml - Form
{l
L public Formli)
{
InitializeComponenty ;
- 1
& private woid buttonl_Click{object zender, Eventirzz &)
{
hyte []data = new hyte[30];
PACNET _Swe GetilEFersiondata);
Meszazebox Show( PACHNET _HISC WideString(datal);
r 1
r 1
-1
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4.4.5. Upload the Application to WinPAC

WinPAC supports FTP server service. You can upload files to WinPAC or download files from a public FTP

server.

Step 1: On the Build menu, click Build SDKInformation

File Edit Yiew Project Debug Tools Test Window Help
" Build Solution  Ctl+Shift+B

| Rebuild Solution

Deploy Solution

Clean Solution

Build SDKInformation

Rebuild SDKInformation

Deploy SDKInformation

Clean SDKInformation

Project Only »

Batch Build...

: Configuration Manager...

|2 Compile Ctr4F7
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Step 2: Open the browser and type the IP address of WinPAC

Step 3: Upload the SDKInformation.exe application and the corresponding PACSDK.dIl and
PACNET.dII files to WinPAC

Tips & Warnings

executing these application on WinPAC, the corresponding PACSDK.dIl and PACNET.dIl must
be in the same directory as the .exe file.

2 For applications programming in C# and VB.net with .net compact framework, when

File Edit View Go Favorites |||]][

[I]ﬁgdress | vTernp

@ & O

PACHET.dI - PacSDK.dI E0ikinformati
ioonexe

WP-2641M-CE7 (WinCE7 Based) User Manual v1.0.1 Page: 87



4.4.6. Execute the Application on WinPAC

After uploading the application to WinPAC, you can just double-click it on WinPAC to execute it.

™

EhKInformat:
L ONeRe
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4.5. First WinPAC Program in Visual C++

The best way to learn programming with WinPAC is to actually create a WinPAC program.
The example below demonstrates how to create a demo program running on WinPAC with Visual C++
To create a demo program with Visual C++ that includes the following main steps:

. Create a new project

. Configure the platform

. Specify the path of the PAC reference
. Add the control to the form

. Add the event handling for the control
. Upload the application to WinPAC

N o o b WON P

. Execute the application on WinPAC

All main steps will be described in the following subsection.

Tips & Warnings

A Before beginning a new project, the “Embedded Compact 7 ATL Update” must be installed.
If this update is not installed, the error message “atlconv.h error C2039: IstrlenW" will be

displayed after the program is compiled.
The update can be found by downloading the latest version from Microsoft.

http://download.microsoft.com/download/9/D/D/9DDBD3EC-A43C-4BCE-A7A9-AEE9B1007
BCE/VisualStudioDeviceWindowsEmbeddedCompact7.msi
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4.5.1. Create a New Project

The Visual C++ project template is a composite control that you use in this example creates a new

project with this user control.

Step 1: Run the Visual Studio 2008

Visual Studio 2008

"2

Step 2: On the File menu, point to New, and then click Project

@) Start Page - Microsoft Visual Studio (Administrator)
Edit View Tools Test Window Help

New » o] Project. Ctrl+Shift+N

Open » '@  WebSite.. Shift+Alt+N
’ Close ] | File.. Ctrl+N

Close Solution Project From Existing Code...

Save Selected Items  Ctrl+5S
Save Selected [tems As..
i@l | Save All Ctrl+Shift+S

Export Template...

Page Setup...

Print.. Ctrl+P
Recent Files >
Recent Projects b
Exit

WP-2641M-CE7 (WinCE7 Based) User Manual v1.0.1 Page: 90



Step 3: In the Project types pane, expand Visual C++, and then click Smart Device
Step 4: In the Templates pane, click MFC Smart Device Application

Step 5: Type a name in the Name field, and then click OK

Here we will enter the name “SDKInformation” and a different location for the project if

you wish

Project types: Templates: NET Framework 3.5 » I

a Visual C++ Visual Studio installed templates
ATL ﬂATL Smart Device Project 4@ MFC Smart Device ActiveX Control
CLR *f& MFC Smart Device Application sifs MFC Smart Device DLL
Eqir;:eral ,E‘WinSE Smart Device Project

Smart Device My Templates

Test

Win32
» Other Languages
» QOther Project Types
» Test Projects

cilSearch Online Templates..

An application for Windows Mobile and other Windows CE-based devices that uses the Microsoft Foundation Class Library

MName: SDKInformation
Location: CA\Users\Administrator\Documents\Visual Studio 2008\Projects -
Solution Name: SDKInformation Create directory for solution

o] [ conea |
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Step 6: On the first page of the wizard, click Next

MEC Smart Device Application Wizard - SDKInformation ‘r

Welcome to the MFC Smart Device Application

Wizard
DWEryiem These are the current project settings:
PlatForms & Windows Mobile 5.0 Pocket PC SDK Platform
yealieetiten Ty ® Single document interface
Dacurnent Template Strings Click Finish from any window to accept the current settings.
User Interface Features After you create the project, see the project's readme. txt file for information about

Advanced Features the project features and files that are generated.

Generated Classes

Step 7: On the next page of the wizard, select GuruCE_imx6_SDK to be added to the project,
and then click Next

MEC Smart Device Application Wizard - SDKInformation

-]
= -]
. ~===m Platforms

OvErview Select platform SDKs to be added to the current project.
PlatFarms
Application Type
. Installed SDKs: Selected SDKs:
Document Template Strings —

Packet PC 2003 GuruCE iMX6 SDE.
User Interface Features Smartphone 2003

Windows Mobile 5.0 Pocket PC SC -
Advanced Features Windows Mabile 5.0 Smartphone b
Generated Classes ¥PacSDK_CE

WEXBxGM1 E

PACZTD

AM335x_WIMCET_SDK

GuruCE iMX5 SDK

Instruction sets: ARMuv4L

< Previous ] [ MNext > ] [ Finish ] ’ Cancel
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Step 8: On the next page of the wizard, select Dialog based, and then click next

MFC Smart Device ﬁaﬁlication Wierd - SDKInformatio

Application Type
Overview Application type:
Flatforms ] Single document

Application Type ® Dialog based

Document Template Strings O Single document with DocList

User Interface Features o

Advanced Features
Resource language:

=X (=H)

Generated Classes

ment/View architecture suppe

Use of MFC:
() Use MFC in a shared DLL

@) Use MFC in a static library

<Previous|[ Next > H Finish H Cancel

Step 9: On the next page of the wizard, click next

-

MFC Smart Device ApElication Wizard - SDKInformatiol

User Interface Features

Overview Command bar:

Platforms © Menus only

Application Type Menus and buttons

Document Template Strings

User Interface Features 2kt
Advanced Features Dialog title:
Generated Classes SDKInformation

<Previous|[ Next > H Finish H Cancel
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Step 10: On the next page of the wizard, click next

MFC Smart Device Aﬁglication Wizard - SDKInformatio

Advanced Features

Overview Advanced features:
Flatforms Windows Help
Application Type Printing and print pr

Document Template Strings B Activex controls
User Interface Features B windows sockats

Advanced Features

Number of files on recent file list:
Generated Classes

4 |w

|
< Previous][ Next > H Finish H Cancel
b ’y
Step 11: On the next page of the wizard, click Finish
MFC Smart Device AEElication Wizard - SDKInformatio!
Generated Classes
overview Generated classes:
Flatforms CSDKInformationApp
CSDKInformationDlg
Application Type
Document Template Strings
User Interface Features . _—
Class name: h file:
Advanced Features CSDKInformationApp SDKInformation.h
Generated Classes
Base class: cpp file:
CWil v SDKInformation.cpp
|
A
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4.5.2. Configure the Platform

When developing applications by using Visual C++, you must configure the Platform to indicate what
platform and device you intend to download the application to. Before you deploy your project, check

the platform.

On the Debug configuration toolbar, select Release, and then on the Pocket PC 2003 (ARMV4)

configuration toolbar, select GuruCE_imx6_SDK(ARMv4I), as shown in the following illustration.

Release  « |GuruCE iMX6 SD]=| @ main -
T e GuruCE iMX6 SDK (ARMvAD) [y e
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4.5.3. Specify the Path of PACSDK library and header files

The PAC SDK provides the PACSDK library and header files with WP-2641M-CE7.
It’s compatible with C++. In order to use a component in your application, you must first add a reference

toit.

Step 1: Right-click the project name, and then click Properties

gt;iuﬁdn Exl;lorer ? SDK]nformatibﬁ

2 [2E &

: ‘_a Solution SDKInformetion’ ‘(Vlhproject)'

EBEz| SDKInformation
@ [ res %Y Build
[£] ReadMe. txt :
Rebuild
h] Resource h :
h] Resourceppe h Deploy

¢+ SDKInformatioy Clean
] SDKInformatioy .
i SDKInformatioy Project Only »

¢+ SDKInformatios Custom Build Rules...
h] SDKInformatios

3 SDKInformatios Tool Build Order...

43 SDKInformatiny Add >
C+4] stdafx.cpp

_nJ stdafx h References...

&5, View Class Diagram

Set as StartUp Project

Debug 4
# Cout

b

X Remove
Rename
Unload Project
?j' Qpen Folder in Windows Explorer

‘. Properties
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Step 2: In left pane, expand Configuration Properties, and then click Link

Step 3: In the right pane, choose the PACSDK_CE.lib in the Additional Dependencies item

SDEInformation Froperty Pages

Crufignration: | Active Debug) v | Elatorm: | ctive (XPacSDK_CE (:36)) | [ Contigurstion Manager... |
Com.'l_mn P_roperl:iss ) Additional Dependencies PACEDK Lib E]
=) Configuration Froperties Tgnore Al Default Libraries Wa

General I Specific Lib
Debugei gnore Specific Libraos
Dieployment Module Definition File
CiC4+ Add Module to Assmbly
= Linker .
Gleneral Embed Managed Fesource File
Tnput Faorce Symbol References
Mamifest Fil: Delay Loaded DLLs
Debngging Aszembly Link Resowce
Srsten
Orptimization
Embedded IDL
Advanced
Cormmand Ling
Resoumes
HML Document Generator
Browse Infornmation
Build Events
Cugtom Budd Step
Authenticode Sizning
Additional Dependencies
Specifies additional items to add to the link lne (ex: kemel®2 1ib); configuration specific.
[ me | =@ |
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Step 4: In the right pane, choose the following path in the “Additional Include Directories”

item

C:\Program Files\Windows CE Tools\SDKs\GuruCE imx6 SDK\Include\Armv4i
C:\Program Files\Microsoft Visual Studio 9.0\VC\ce7\atImfc\include

SDKInformation Property Pages

Configuration: ‘_{:;i‘.’-s(R-sl

snoa

case)

v| Blatform: [Active(GuruCE iMX6 SDK (ARMv4D) |v| [ Canfiguration Manzger... |

‘ ~

Common Properti¢/»
= Configur,

ation Pror
al

Gen

Debugging
Deployment
2 C/C++
General
Optimization
Preprocessor

Language
Precompiled
Output Files
Browse Infor
Advanced
Command L:

Linker

Resources

XML Documen

Browse Inform: .

o Ranald Farmnss —

>

Additional Include Directories

Resolve #using References

Debug Information Format
Suppress Startup Banner

Warning Level

Detect 64-bit Portzbility Issues

Treat Warnings As Errors

Additional Include Directories

"C:\Program Files\Windows CE Tools\SDKs\GuruCE iMXG

Program Database (/71)
Yes (mologo)

Level 3 (/W3)

No

No

Specifies one or more directories to add to the include path; use semi-colon delimited list if more than one.  (/I[pa...

Lz [ fs | =RG
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4.5.4. Add the Control to the Form

You can drag various controls from the Toolbox onto the form. These controls are not really "live"; they

are just images that are convenient to move around on the form into a precise location.

After you add a control to your form, you can use the Properties window to set its properties, such as
background color and default text. The values that you specify in the Properties window are the initial

values that will be assigned to that property when the control is created at run time.

Step 1: In Resource View, expand the resources tree by opening the top level folder

Step 2: Open the Dialog folder and then double-click the dialog resource name
IDD_SDKINFORMATION_DIALOG

Resource View - SDKInformation =

=54 SDKInformation
= SDKInformation.rc
+-_J Icon
#-{ 1 Version
[+ SDKInformationppe.rc

quRes:-urce View @ Solution Explorer | Properties

The resource editor appears in the right pane.
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Step 3: From the Toolbox, drag a Button control onto the form

Toolbox 3]
£

|a Button

[X] Check Box

ab| Edit Control

Combo Box

List Box

m Group Box

(¢ Radio Button

An Static Text

Picture Control

[ Horizontal Scroll Bar
B vertical Scroll Bar
D~ Slider Control v

g Server Evploes| s Toolbox |

=

=) Dialog Editor
QSD“KInfomﬁon.m... - Dialog*|

R Pointer
4 i .

Ll

E

TODO: Flace dialog contiols heye.

L,,,|....|....l..ulﬂ!l

Step 4: Right-click the Button control, and then click Properties

RS

(But_n
=] | [] % Cut
7 5a  Copy
’: TODO: Flace dialog contuol a
o X Delete
Add Event Handler...
Insert Activel Control...
v Add Class...
v Add Varisble...
Size to Content
=
it
@7 Check Mnemonics
P;operﬁes
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Step 5: In the Properties window, type Check the SDK version, and press ENTER to set the Text
property

Properties _________________®

IDC_BUTTON1 (Button Control) ICeButtonEditor ~

II L3

Appearance A-.
Check be SD version.
Client Ed ge False
Horizontal Alignment Default =
Modal Frame Fale
Multiline Fale
Notify False
e N ] v

Capuon ' '

Specifies the text displayed by the control.

E’E]Reé:juxté Tiew j??}ijdlijﬁ':’ﬁ Explorer }ﬁpmperﬁes "
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4.5.5. Add the Event Handling for the Control

You have finished the design stage of your application and are at the point when you can start adding

some code to provide the program's functionality.

Step 1: Double-click the button on the form

SDKInformation.rc.. 327 (£H)] - Dialog* = x

3 5] u a
o m| Check the SDK version ]-
3 5] [] o

R TODO: Flace dialog contiols heye.

Step 2: Inserting the following code

char sdk_version[32];

TCHAR buf[32];
pac_GetSDKVersion(sdk_version);
pac_AnsiToWideString(sdk_version, buf);
MessageBox(buf,0,MB_OK);

pvold CEDEInformationlle: :OnEnC]lickedButtonl)

{
JTODO: &dd wour control notification handler code here
char zdk_version[32];
TCHAR buf[32];
pac_GetilEVersion(=dk version);
pac_AnziToWidestring(sdk_version, buf);
MezsageBox{buf 0 ,MB_0K);

h
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Step 3: Inserting the following code into the header area

#include “PACSDK.h”

#include "stdafx . h"

#include "SDEInformation_h"
#include "SDEKInformationDle . h"
#Finclude "PACSDE.H"
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4.5.6. Upload the Application to WinPAC

WinPAC supports FTP server service. You can upload files to WinPAC or download files from a public FTP

server.

Step 1: On the Build menu, click Build SDKInformation

File Edit View Project Debug Tools Test Wimndow Help
[ﬁ Build Solution Ctc+Shift+B ]
| Rebuild Solution
Deploy Solution

‘ Clean Solution

|| [#% Build SDKInformation
Rebuild SDKInformation
Deploy SDKInformation
Clean SDKInformation
Project Only 3
Batch Build....

; Configuration Manager...

; £ Compile Ctl4+F7
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Step 2: Open the browser and type the IP address of WinPAC

Step 3: Upload the SDKInformation.exe application to WinPAC

|Eile Edit View go|
@ pj =R

-

SR, CERIEE:
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4.5.7. Execute the Application on WinPAC

After uploading the application to WinPAC, you can just double-click it on WinPAC to execute it.

™

EhKInformat:
L ONeRe
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5. APIs and Demo Programs

This chapter provides a brief overview of PAC APls and demo programs that have been designed for ICP
DAS PACs.

ICP DAS provides a set of demo programs in different programming languages. You can examine the
sample codes, which includes numerous comments, to familiarize yourself with the PAC APIs. This will

allow developing your own applications quickly by modifying these demo programs.

For full usage information regarding the description, prototype and the arguments of the functions,

please refer to the “PAC Standard API Manual”

E PAC_Standard API Manuwal 1.1.1 pdf - Adobe Acrobat Pro

BED WRE BRG RE0H 50 T«
Ber- | BOOPE| e RBRD =0 - | [f
P vl NG 0@ =[] HB I %B &8
L |e= 15 2. PAC API Functions -
o = B @
- 2.1. System Information APT
& fant, n cenneans =P 2.1. System Information 4PT &
léfd' P 2‘1._3. pac_GetSerialNumber I:F 2.1.1. [:IEIE_GENDdUlENamE
[P 2.1.4. pac_GetsOKversion
[Pais pac_ChangeSiat E paE_GEtRDtarYID
EF 2.1.6. pac_CheckSDKVersion .
P 217, poc ModieExiss 4 I:F 2.1.3. pac_GetSerialkumber
gig PSE—EEES“E;’;‘“” [P 214 par_GetSDKVersion
L9, pac_Gelviad Iress
[F 2110, pac_Repoat I:P 2.1.5, pac_changeSiot
[P 2111, Pac_GatcPuy
o1 pZE_E:ah‘ELEZrSIDn I:F 2.1.6. pac_CheckSDKYersion
[P 2.1.13. Pac_EnableLEDs .
EF 2.1.14. pac_BackwardCompatible E 2'1'?' FIEIE_MDC'U'EE}{lStB
EFZLIS. pac_GetEhootyersion E 218 Flal: GEtOSI"."IErSiDn
[P 2116, pac_cetComMapping -
[P 2.1.17. pac_GetvoduleTyps E 2.1.9, pac_Geﬂ\ﬂaE.-’-‘-.ddress
[Pa11s pac_GetPachetyersion
EF 2.1.19. pac_PuzzerBeep E 2'1'10' paE—REE'DDt
= [P 2.1.11. Pac_GetCPUversion —

[P 2.1.12. Pac_EnablelED

[P 2.1.13. Pac_EnableLEDs

[P 2114 pac_BackwardCompatible
EF 2.1.15. pac_GetEbootversion

l:lg 2.1.16. pac_GetZomiapping

[P 2117 pac_GettModuleType

I:P 2.1.18, pac_GetPacMetersion

[P 2.1.19. pac_Puzzergeep

[
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5.1. PAC Standard APIs

The diagram below shows the set of each system operation API provided in the PACSDK.

| I l » System Information » Watchdog
I [ » Backplane Access » UART
» Backlight » Registry
| > Interrupt » Buzzer
» Memory Access > LED

System Operation
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5.1.1. VB.NET Demo Programs for PAC Standard APIs

The PAC SDK includes the following demo programs that demonstrate the use of the PAC Standard APls

in a VB.NET language environment. The following demo programs can be found by downloading the

latest version from ICP DAS web site.

For VB.NET applications, these demo programs can be obtained from:
http://ftp.icpdas.com/pub/cd/winpac imx6/WP-2641/demo/pac/vb.net/standard/

Folder

buzzer

Demo

buzzer

Explanation

Shows how to make a simple buzzer beep.

Devicelnformation

Devicelnformation

Retrieves information about the OS version, CPU

version, SDK version, etc.

GetRotaryIlD

GetRotaryID

Retrieves information about the

status of the rotary switch

Shows how to read/write data

Memory Memory values from/to the EEPROM or
the backplane of the SRAM
MicroSD MicroSD_Management | Shows how to manage the microSD

VB_UI_Call_VC_Realti

Writes the managed cod for the rich graphical

user interface that does not require true

me real-time
RealTimeTest
performance
Shows how to use the function of JIT compiler
VBOnly
and garbage collector
Shows how to read/write data
Registry Registry
values from/to the registry
Shows how to read the name of a
UART UART
local I/O modules via a UART
Displays information about how to
WatchDog WatchDog

operate the watchdog
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5.1.2. C# Demo Programs for PAC Standard APIs

The PAC SDK includes the following demo programs that demonstrate the use of the PAC Standard APls

in a C# language environment. The following demo programs can be found by downloading the latest

version from ICP DAS web site.

For C# applications, these demo programs can be obtained from:
http://ftp.icpdas.com/pub/cd/winpac_imx6/WP-2641/demo/pac/c%23/standard/

Folder

buzzer

Demo

buzzer

Explanation

Shows how to make a simple buzzer beep.

Devicelnformation

Devicelnformation

Retrieves information about the OS version, CPU

version, SDK version, etc.

GetRotarylD

GetRotaryID

Retrieves information about the

status of the rotary switch

Shows how to read/write data

Memory Memory values from/to the EEPROM or
the backplane of the SRAM
MicroSD MicroSD_Management | Shows how to manage the microSD

CSharp_Ul_call_ VC_Re

Writes the managed cod for the rich graphical

user interface that does not require true real-time

altime
RealTimeTest performance
Shows how to use the function of JIT compiler
CSharpOnly
and garbage collector
Shows how to read/write data
Registry Registry
values from/to the registry
Shows how to read the name of a
UART UART
local I/O modules via a UART
Displays information about how to
WatchDog WatchDog

operate the watchdog
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5.1.3. Visual C++ Demo Programs for PAC Standard APIs

The PAC SDK includes the following demo programs that demonstrate the use of the PAC Standard APls

in a Visual C++ language environment. The following demo programs can be found by downloading the

latest version from ICP DAS web site.

For Visual C++ applications, these demo programs can be obtained from:
http://ftp.icpdas.com/pub/cd/winpac imx6/WP-2641/demo/pac/vc2008/standard/

Folder

buzzer

Demo

buzzer

Explanation

Shows how to make a simple buzzer beep.

Devicelnformation

Devicelnformation

Retrieves information about the OS version,

CPU version, SDK version, etc.

GetRotaryIlD

GetRotaryID

Retrieves information about the

status of the rotary switch

Shows how to read/write data

Memory Memory values from/to the EEPROM or
the backplane of the SRAM
MultiRT MultiRT Shows how to manage the microSD

RealTimeTest

RealTimeTest

Writes the managed cod for the rich
graphical user interface that does not require

true real-time

performance
Shows how to read/write data
Registry Registry
values from/to the registry
Shows how to read the name of a
UART UART
local I/O modules via a UART
Displays information about how to
WatchDog WatchDog

operate the watchdog
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5.2. PACIO APIs
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5.2.1. VB.NET Demo Programs for PAC Standard APIs

The PAC SDK includes the following demo programs that demonstrate the use of the PAC IO APIs in a

VB.NET language environment. The following demo programs can be found by downloading the latest

version from ICP DAS web site.

For VB.NET applications, these demo programs can be obtained from:

http://ftp.icpdas.com/pub/cd/winpac imx6/WP-2641/demo/pac/vb.net/io/

Folder

Explanation

XVBoard/XV107

XV107_Modbus_RTU_Master_ | Shows how to use the XV107 module of
VB_demo the XV-board

Remote
(1-7000 or I-87K modules
in RU-87Pn 1/0 unit)

For full details regarding the remote I/O modules and its demos, please
refer to:

http://ftp.icpdas.com/pub/cd/winpac imx6/WP-2641/demo/pac/applica

bled demo for 7k module.pdf
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5.2.2. C# Demo Programs for PAC Standard APIs

The PAC SDK includes the following demo programs that demonstrate the use of the PAC IO APIs in a C#
language environment. The following demo programs can be found downloading the latest version from
ICP DAS web site.

For C# applications, these demo programs can be obtained from:

http://ftp.icpdas.com/pub/cd/winpac imx6/WP-2641/demo/pac/c%23/io/

Folder Demo Explanation

Shows how to use the XV107 module of
ModbusRTU_Master_Console

the XV-board in console mode

XVBoard/XVv107
XV107_Modbus_RTU_Master | Shows how to use the XV107 module of
_demo the XV-board
For full details regarding the remote I/0O modules and its demos, please
Remote

refer to:
http://ftp.icpdas.com/pub/cd/winpac imx6/WP-2641/demo/pac/applic
abled demo for 7k module.pdf

(I-7000 or I-87K modules in
RU-87Pn 1/0 unit)
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5.2.3. Visual C++ Demo Programs for PAC Standard APIs

The PAC SDK includes the following demo programs that demonstrate the use of the PAC Standard APls
in a Visual C++ language environment. The following demo programs can be found downloading the
latest version from ICP DAS web site.

For Visual C++ applications, these demo programs can be obtained from:
http://ftp.icpdas.com/pub/cd/winpac_imx6/WP-2641/demo/pac/vc2008/io/

Folder Demo Explanation

For full details regarding the remote I/O modules and its demos, please
Remote

(I-7000 or I-87K modules
in RU-87Pn I/0 unit)

refer to:
http://ftp.icpdas.com/pub/cd/winpac imx6/WP-2641/demo/pac/applica
bled demo for 7k module.pdf
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6. 1/0 Modules and SDK Selection

This chapter describes how to select a suitable 1/O expansion module and the corresponding SDK library

to be used for developing programs on WinPAC series devices.

Selecting an SDK Library for 1/0 Expansion

I-8KE4 ET-7000

RS-232/RS-485

RU-87Pn M-7000 1-7000

0 Local I/0 Module (XV-Board)

There are more than 8 XV-Board available for expanding the function of the WP-2641M-CE7 The
following table shows the appropriate SDK library to be used for I/O modules.

Module Native SDK .NET CF SDK

XV-Board Modbus Demo Modbus Demo

For more detailed information about these support modules, please refer to

http://www.icpdas.com/root/product/solutions/hmi touch monitor/touchpad/xv-board selection.html
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9 RS-485 (1-7000 series and M-7000 series)

[-7000, M-7000, RU-87Pn and high profile I1-87K series modules connect to WP-2641M-CE7 via a

twisted-pair, multi-drop, 2-wire RS-485 network.

» 1-7000 series I/0 modules

Module ‘ Native SDK ‘ .NET CF SDK ‘
I-7000 series PACSDK.dII PACNET.dII
[-7000 series with 1-7088 (D) PACSDK_PWM.dII PACNET.dII

For full details regarding 1-7000 series I/0 modules and its demos, please refer to:
http://ftp.icpdas.com/pub/cd/winpac_imx6/WP-2641/demo/pac/applicabled demo for 7k module.pd
f

» M-7000 series /O modules

Module Native SDK .NET CF SDK

M-7000 series Modbus Demo Modbus Demo

For more detailed information about M-7000 series modules using Modbus protocol and its demos,
please refer to:
http://ftp.icpdas.com/pub/cd/winpac_imx6/WP-2641/demo/nmodbus/

» RU-87Pn + I-87K series I/O modules

Native SDK .NET CF SDK

RU-87Pn + I-87K PACSDK.dlII PACNET.dII

»  Other specified I/0

Module Native SDK .NET CF SDK

I-7088W PACSDK_PWM.dII PACNET.AII
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8 Ethernet (ET-7000 series and 1-8KE4/8-MTCP)

The Ethernet I/O devices available include ET-7000 and I-8KE4/8-MTCP, and support the

Modbus/TCP communication protocol.

Module ‘ Native SDK ‘ .NET CF SDK ‘
ET-7000 Modbus Demo Modbus Demo
|-8KE4/8-MTCP Modbus Demo Modbus Demo

For more detailed information about ET-7000 and I-8KE4/8-MTCP series modules using Modbus protocol
and its demos, please refer to:
http://ftp.icpdas.com/pub/cd/winpac_imx6/WP-2641/demo/nmodbus/
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7. WP-2641M-CE7 Updates

This chapter provides information of the WinPAC OS and SDKs, and a guided tour that demonstrates the
steps needed to update the WinPAC OS and SDKs.

ICP DAS will continue to add additional features to WinPAC SDK and OS in the future, so we advise you to
periodically check the ICP DAS web site for the latest updates.

Both the files of OS updates and SDK updates can be found by downloading the latest version from ICP
DAS web site.

http://ftp.icpdas.com/pub/cd/winpac_imx6/wp-2641/

update_from_Micro_SD

update_from_file

PlatformSDK
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7.1. OS Updates

OS updates are part of the WP-2641M-CE7 updates services to provide additional and more efficient
features and functionality for WP-2641M-CE7 operating system.

The updates files of OS image can be found by downloading the latest version from ICP DAS web site.

http://ftp.icpdas.com/pub/cd/winpac_imx6/wp-2641/os_image/

update_from_Eshell_or_Micro_SD

update_from_file

There are two ways to update the OS:

OS image
' I

update from Eshell

update from Micro SD

1. Update from eshell (Please refer to section 7.1.1)

(We recommend that you use this one for more quicker and easier to update)

2. Update from micro_SD (Please refer to section 7.1.2)
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7.1.1. OS Updates using Eshell

By default, the OS updates via LAN. Therefore, to update the

OS image, make sure LAN is connected to the PC.

Step 1: Get the latest version of the installation package file and then
unzip it

The latest version of the installation package file can be found from ICP DAS web site.
http://ftp.icpdas.com/pub/cd/winpac_imx6/WP-2641/0s image/update from eshell or

micro_sd/

Step 2: Run the registry clear.exe

The registry.exe can be found by downloading the latest version from ICP DAS web site.
http://ftp.icpdas.com/pub/cd/winpac_imx6/WP-2641/pc_tools/eshell/

ESNE L
Run the
registry clear.exe

Step 3: Place the rotary switch in position 3, OS update mode
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Step 4: Run the ESHELL.exe, and then restart the WP-2641M-CE7

ESHEL

The ESHELL.exe can be found by downloading the latest version from ICP DAS web site.

http://ftp.icpdas.com/pub/cd/winpac imx6/WP-2641/pc tools/eshell/

Step 5: Select the device which you want to update the OS image, and then click OK

Select the device name which you want to update the OS image from the list.

Entet Device M ame:

[WINPAC270_535

Or Sedect From the List

i

Ok

Cancel

Reset devices to
automatically puk
names on the
list.

Step 6: Select the latest version of the OS image file

=~ e EBerE

Look in: | |05 WP523x_ 20140821 Ver10.0.4_ml
My Recent
Diocumenits
Deskiop
My Documents
My Computes
Fil : WE BIN
My Network ile: niame:
Files of type: NE Image

o Wi O Db bagg Bl - WIF_BE000 SARE T S Waal b Dlsagd oo STHND

o MO _ma ge'e g 2wl a

aF_sahil | Baetieader Bersios 1,8, IF; 8.1 ,0,50, S eEeF o abes

Gownlesding “Vilddyod PitiaFEDsepdenteg - TR el INEE | mege'iovp - Flulapdats_Fron [ vbeE1%rmtE
Replag Ud Laage o OF_MWPE ...
Eonmriling te W_nhiidl wsing Diheresi, ..
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Step 7: Once the procedure is completed, the “Warning !” dialog box will appear as below
shown, then turn the rotary switch in position 0, normal mode

Warning

"'-..‘ Reboot this device right nowy |
L Flease turn the rotary switch to 0 - normal

Step 8: Click the OK button

YWarning
'.": Reboot this device right now |
s Please turn the rotary switch to 0 - normal

Step 9: Check the OS version

Start the PAC Utility, and then select the “Device Information” tab to check the current OS

version.

Double-click the
PAC Utility shortcut

st [ ] cPU Type: [wPsz3c |
Stz [ ] Serial Number: [p1-a8-2c-1F-1600-0020 |
Slot 3: I:I Backplane ‘Yersion: |NJA |
Slot 4 |:| CPU Yersian: |N;A |
Slot 5 I:I 0S Yersion: |1001 |
Slot &: |:| NET CF arsion: |3,5,?333,gg |
Slat 7: |:| SQL CE Yersion: | |

|

PACSDK Version: |4,3,n.u
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7.1.2. OS Updates using micro_SD

The microSD card can be used to reinstall the WP-2641M-CE7 OS image to factory default settings in the
event of the WP-2641M-CE7 failure.

% WP523x 20140821 Yer.1.0.0.4_ml

File Edit View Favorites Tools  Help

@Eack ML > | l_'ﬁ: /.7‘: Search || Folders

Aeddress |5 Criapdate_from_Eshell_or_Micro_SDWWPSZ3x_20140( ’- Pioe
- N P iCro
| S

EBOOTED b0
[ MLO £y NK bin
Byl 5%, K | Apple o
m) o)

Step 1: Get the latest version of the installation package file and then
unzip it

http://ftp.icpdas.com/pub/cd/winpac imx6/WP-2641/os image/update from eshell or
micro sd\

Step 2: Run the CEWrite.exe
CEWriter

The CEWriter.exe can be found by downloading the latest version from ICP DAS web site.
http://ftp.icpdas.com/pub/cd/winpac_imx6/WP-2641/pc_tools/cewriter/
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Step 3: Select the drive of the connected micro SD, and then click Write!

Make sure the correct drive is selected in the “Drive” list, and press “Writel” to start the

flashing process.

-

B GuruCE CEWriter v3.0.0.0 l = | |-?3-I1

Dive: [37GEdsk, 1pariion: U: (36GB) v || Refresh |

Bootloader: C:\GuruCEheboot bin
Kemel: C:\GuruCE\NK bin
Boot splash:  C:AGuuCEMGurnuCE logo bmp

Max boot splash resolution: 13201080 - [ Erase boot splash ]

Erase boot corfig Always partition disk

Tips & Warnings

A

The GuruCE CEWriter tool allows you to quickly and easily flash the OS kernel and any boot
splash screen image to an attached Micro_SD card.

CEWriter reserves 136 MB at the very beginning of the Micro_SD card. The boot splash
screen image and OS kernel are stored in this space. CEWriter partitions the remaining

space as an exFAT partition that can be used in Windows CE (and on your PC) to store files.

CEWriter also automatically converts the splash screen image to be a single plane, 24bpp
bitmap image. You can select jpg, png or bmp files as boot splash screen image. When using
CEWriter make sure you select the correct drive from the “Drive” list.

The “Erase boot splash” button erases an existing boot splash screen image from the
Micro_SD card.

The “Erase boot config” button erases the boot configuration, so the next time you boot
using this Micro_SD card, the bootloader will revert to factory defaults.
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Step 4: Plug the microSD card into microSD slot

Step 5: Turn the rotary switch in position 5, OS update mode

Step 6: Reboot the WP-2641M-CE7

Step 7: Wait a few minutes for the following desktop to be displayed
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Step 8: Turn the rotary switch in position 0, normal mode

Step 9: Reboot the WP-2641M-CE7

Step 10: Check the OS version

Start the PAC Utility, and then select the “Device Information” tab to check the current OS

version.

Double-click the
PAC Utility shortcut

Slot 1; |:| CPU Type: |Wp523>{ |
otz [ ] Serial humber: [01-88-2C-1F-16-00-00-20 |
Slat 3 |:| Backplane Yersion: |Nm |
Slot 4 I:I CPL “ersion: |NIA |
Slat 5: |:| 05 Wersion: [1001 |
Slot &: |:| MET CF “ersion: [2.5.7338.00 |
Slat 7: |:| SQL CE Yersion: | |

|

PACSDK Version: |4,3.u.n

WP-2641M-CE7 (WinCE7 Based) User Manual v1.0.1 Page: 127



7.2. SDK Updates

SDK updates are part of the WP-2641M-CE7 update services to provide additional and more efficient
features and functionality for WP-2641M-CE7 operating system.

The updates files of SDK files can be found by downloading the latest version from ICP DAS web site.

http://ftp.icpdas.com/pub/cd/winpac_imx6/wp-2641/sdk/

.
.
.
.
.
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7.2.1. SDK Updates for VB.NET or C#

You can just change the old one with a new one.

Step 1: Get the latest version of the PACNET.dII

The latest version of the PACNET. dll can be obtained from ICP DAS web site.
http://ftp.icpdas.com/pub/cd/winpac imx6/WP-2641/sdk/pacnet/

Step 2: Copy the PACNET.dII file to PC and WP-2641M-CE7

The DLL files on PC are located at anywhere only the solution can reference it.
The DLL files on WP-2641M-CE7 are located at the same directory as the .exe file.
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7.2.2. SDK Updates for C++

You can just change the old one with a new one.

Step 1: Get the latest version of the VC++ components

The latest version of the VC++ components can be obtained from:
http://ftp.icpdas.com/pub/cd/winpac imx6/WP-2641/sdk/pacsdk/

Step 2: Copy the latest version of header files and libraries to Host PC

The header files are located at:

C:\Program Files\Windows CE Tools\SDKs\GuruCE imx6 SDK\Include\Armv4i
The libraries are located at:

C:\Program Files\Windows CE Tools\SDKs\GuruCE imx6 SDK\lib\ARMv4I

Step 3: Copy the latest version of DLL files to WinPAC

The DLL files are located at:
\System_Disk\ICPDAS\System
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Appendix. A. Tips — How to
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A.1. How to Online Debug the WP-2641M-CE7 Program

Here are step by step instructions on how to online debug the WP-2641M-CE7 program.

Tips & Warnings

A

Before starting online debug the WP-2641M-CE7 program, make sure that the
WP-2641M-CE7 SDK has been installed correctly.

For more information on how to install the WP-2641M-CE7 SDK, please refer to 4.2.

Installing WP-2641M-CE7 SDK.

Step 1: Copy the following files to the \System_Disk\icpdas\system on the WP-2641M-CE7

By default, these files are located on the development computer at C:\Program
Files\Common Files\Microsoft Shared\CoreCon\1.0\Target\wce400\<CPU>.

clientshutdown.exe

CMAccept.exe

ConmanClient2.exe

eDbgTL.dll

TcpConnectionA.dll

Step 2: Run the ConmanClient2.exe and then CMAccept.exe on the WP-2641M-CE7

I]].&erESS | WSystem_Diskicpdassystemn
CTRC I T B Y Y
atlan atlan autoinit rmfcanchs mfc80cht  mfc20deu
LT T Y B Y N Y I CY
rnfce0ipn rnfcS0kar rnfca0u rnfca0ud mfcSdchs  mfic90cht
L R Y R Y B Y I CY
rfcS0fra rnfc20ita rnfcS0ian rnfc20kor rnfc20u rnfcS0ud
T R Y R Y RN
pacnet pacsdk  pacsdk_pwrn eDbgTL TopConne... clientshis,, .
‘w—\_/ﬂquwmwvw—wm

)

rnfc80enu

)

rnfcS0deu

0y

rmfcE0esp

®

rnfc20emnu

B
mchlDfra§
IS
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Step 3: On the Tools menu, click the Options...

File Edit View Project Build Debug Test Window Help
h.in vid v d ﬂ| & B3 _:L,| “) - |_-i Attach to Process... Ctrl+Alt+P

AM335x WINCE7_SDK AF v | Ei‘ ﬁ | g ﬂa Device Security Manager...

Connect to Device...

External Tools...

Import and Export Settings...

Step 4: In the left pane, expand Device Tools node and select Devices

Step 5: In the Show devices for platform:, select GuruCE_imx6_SDK and then click Properties

@--Envimmnen‘[ T e [0F DIae
= Projects and Solutions

é--SDurce Control u )
Er Text Editor > /
@ Datzbzse Tools
& Debugging

= Device Tools

- General

GuruCE iMX6 SDK A 7’7;;-{\-"? Device

------ Form Factors

o HTML Designer

= Office Tools

o Test Tools

o Text Templating

= Windows Forms Designer
o Workflow Designer

Properties...

[ O e T e N v N e NN =

Default device:
GuruCE iMX6 SDK ARMV7 Device v|

| ok ]| Cancel
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Step 6: Click the Configure...

GuruCE iMX6 SDK ARMV7 Device Properties

Default output location on device:

Program Files Folder

Transport:

TCP Connect Transport

Configure...

Bootstrapper:

ActiveSync Startup Provider v Conficure...

Detect when device is disconnected

Step 7: Select the Use specific IP address:, and then type the IP address of WP-2641M-CE7

Configure TCP/IP Transport M
-

"] Use fixed port number: 5655

Device IP address

() Obtain.ap P address automatically using ActiveSync

@ Use specific IP address:

10.1.0.96]

OK J ‘ Cancel
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Step 8: Click the OK, and then click OK to end the dialog

GuruCE iMX6 SDK ARMV7 Device Properties

Default output location on device:

‘I rogram Files

Transport:

TCP Connect Transport | Configure... |
Bootstrapper:

‘A:tik'-eS}-'n: tartup Provider "‘ Configure...

Detect when device is disconnected

Environment Show devices for platform:
Projects and Solutions

i GuruCE iMX6 SDK v|
Text Editor Devices:
Datzbzse Tools _

Debugging GuruCE iMX6 SDK ARMV7 Device l Save As... l
= Device Tools l

General IR l
Devices T
Form Factors E

HTML Designer l Properties l

(Office Tools

Test Tools

Text Templating
Windows Forms Designer
Workflow Designer

Default device:
| GuruCE IMX6 SDK ARMVT Device
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Step 9: On the Tools menu, click the Connect to Device...

File Edit View Project Build Debug |Tools | Test Window Help
5 | Attach to Process.. Ctrl+Alt+P

evice Security Managers

Connect to Device...

Device Emulator Manage
i

Connect base...

Connect to Server...

Code Snippets Manager.. Ctrl+K, Ctrl+B

Step 10: Wait for the connection to be established

To 'GuruCE iMX6 SDK ARMVT Device'

Tips & Warnings

Q If the connection fails, as shown below, please repeat the step 2 to step 9 to try it again.

To 'GuruCE iMX6 SDK ARMV7 Device'
Connection failed.
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A.2. How to Automatically Synchronize WinPAC Clock

You can synchronize your WinPAC clock with an Internet time server.

If synchronization is enabled, the WinPAC clock is synchronized with an Internet time server.

Step 1: Double-click the PAC Utility on the desktop

Double-click the

PAC Utility shortcutJ

Step 2: On the General tab, press Configure button

PAC Utility [1.2.0.6] ! E

File Help

Generall Display I IF Config I Metwark IDevice Infor mation I ALta Execution IRDtar\,r Execution |

Backplane Battery
Batteryl .

Configure the synchronization with a time server

Welcome o use PAC Liility
Thig tool will help you easy o
use PAC CE series.

Task Bar setting:
[ Auto Hide
[ &bways On Top

HIVE Feqistry:
[] Enable autarun in plugging USE Disk
[] Enable Autorun in plugging Micra SD
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Step 3: Select the domain name from the Server
drop-down list, and then enter a value in
the Autoupdate Frequency field

Step 4: Check the Automatically synchronize with
an internet time server check box

Step 5: On the File menu, click Save and Reboot

Internet Time 1.0.0.1

Stepl: Server:  |tock.usno.nasy. mil El

Step2: Autoupdate Frequency: | | minute
Stepa:

|:| Autornatically synchronize with an internet tirme server

| Update Mow

Save and Reboot

Reboot

Restore Utility Default Settings
Exit

Step 6: The WinPAC will automatically synchronize with an internet time server regularly

Step 7: Click the Update Now button to synchronize WinPAC clock immediately

Internet Time 1.0.0.1

Stepl: Server: | tock.usno.nawy, mil El
Step2: Autoupdate Frequency: | | minute
Step3:

|:| Autornatically synchronize with an internet time server

| Update Mow
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A.3. How to use User Account Control in WinPAC
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A.3.1. How to Create an User Account

Here are step by step instructions on how to add a user account.

Step 1: Double-click the PAC Utility on the desktop

Step 2: On the Login tab of the Network tab, click Login tab, type the User Name and
Password, and then click Add button

PAC Utility [1.2.2.0] !

IGeneraI I General? IDiSpIay IIF' Config | Metwork |De\rice Infor mation Iﬁutﬂ Execution IRDtary E}{d 1 I L4

[ Access | Login |

User MNarme Password
ficroas | | sod || Delete
Lser name | Passwaord |
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Step 3: The user has been added to the allowed under the remote login and included in the

following list

PAC utility [1.2.2.0] !

File Help

[General IGeneraI2 I Display IIF' Config | Metwork |Device Infarmatian IAut: Execution IRotary E}{El 1 I »

[Access| Login |

User Mame Password
licP Das | e | add || Dekete

Password

User name
ICP

Step 4: On the File menu, click Save and Reboot for changes to take effect

Save and Reboot
Reboot
Restore Utility Default Settings

Exit
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A.3.2. How to Use Telnet to remote login the WinPAC from PC

Here are step by step instructions on how to use telnet to remote login the WinPAC from PC.

Step 1: On the PC, open a MS-DOS command prompt

U, ST UL ORRUEE Y. | oo G
=W > 7
A5 Windows Catalog g

<

‘& Windows Update

m Programs 4

2. Type “cmd”

;~ Documents
D * Sefk
7 g
(7] upport

start | o CwiDows\syste. .

s» | Windows XP Professional

[ QK ][ Cancel ] [ Browse...

Step 2: At the command prompt, type “telnet (IP address)”

v CAWINDOWSisystem 32w md _exe

C:“Documents and Settings“Mindows>telnet 18.1_8_31
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Step 3: The connection has been set up, and then type the name and password

+ Telnet 10.1.0.31

llelcome to the Windows CE Telnet Service on Compact

login: ICPDAS
Pazsword:

Step 4: The remote login has been completed

+ Telnet 10.1.0.31

Wlelcome to the Windows CE Telnet Service on Compact

login: ICPDAS
Paszword:
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A.3.3. How to Remove a User Account from the Login List

Here are step by step instructions on how to remote the user from the login list.

Step 1: Click a user from the list which you want to remove, and the user will display in the
field, and then press Delete to delete the user from the login list

PAC Utility [1.2.2.0] !
File Help

[General I General2 IDispIay IIP Config | Hetwork |Device Infor mation IAuU: Execution IRDtary E}d 1 I 4

[ ACCEss | Login |

User Mame Password

ficP Das N || aad | Delete

User name | Password

Step 2: On the File menu, click Save and Reboot for changes to take effect

Save and Reboot
Reboot
Restore Uity Default Settings
Exit
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A.4. How to change the battery

RTC is retained by a Li-ion battery, which can supply continuous power for 10 years. The battery design
has the added function of preventing data from being lost while replacing the battery. The following

figures show the location of the battery installed in the WinPAC CPU board.

Checking the current battery power

1. Run the PAC utility and check the Battery 1 fields that display the current status. Refer to Section 3.1
PAC utility “General” for more details. If the power level is low that the battery should be replaced.

2. When programming this, call the pac_GetBatteryLevel() API function in the PACSDK.dIl to check
whether the battery power is low. When the power of the battery is low, it’s recommended that the

battery is replaced immediately, otherwise the RTC time will be reset.
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Replacing the battery

Power off the WinPAC device.

Remove the CPU board.

Remove the battery that is running low on power from the battery holder in CPU board.
Insert a new battery.

Set the RTC time.

A S

Ordering information

Battery type: BR1632 (Part number is 2LB010 for ICP DAS)

For more detailed information, contact your local sales office or distributor.
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A.5. How to Using the Practical Functions of the 3G/4G I/0O Module

The Mobile network module of WinPAC series (Except for WP-2641M-CE7) that use the 3G/4G network

to implement SMS and GPRS connection to send and receive functions.

WP-2641M-CE7 (WinCE7 Based) User Manual v1.0.1 Page: 147



A.5.1. How to Auto Dial 3G/4G GPRS network and redial when the network
disconnected

The AutoDialer allows user to automatically dial GRPS network after boot.

When the GRPS network disconnect the AutoDialer will automatically re-dial Internet access.

Tips & Warnings

ABefore installing the SIM card, please cancel the PIN lock function of SIM card;
otherwise you will not be able to dial the Internet

The demos can be found by downloading the latest version from ICP DAS web site.

http://ftp.icpdas.com/pub/cd/winpac imx6/wp-2641/demo/3g modem/autodialer/

The description of the demo can be found by downloading the latest version from ICP DAS web site.

http://ftp.icpdas.com/pub/cd/winpac imx6/wp-2641/document/faqg/development/

W5-13 How_to_use_Auto_dial_GPRS_network_and_redial_when_the_network_disconnected_en
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A.5.2. How to Use the SMS Function and Get the GPS Data

The 3G/4G modem allows the user to use the SMS function and get the GPS data.

The APl manual can be found by downloading the latest version from ICP DAS web site.
http://ftp.icpdas.com/pub/cd/winpac imx6/wp-2641/demo/3g modem/3g modem sms demo/gsm li
b manual v1.0.1.pdf

The demos can be found by downloading the latest version from ICP DAS web site.

http://ftp.icpdas.com/pub/cd/winpac imx6/wp-2641/demo/3g modem/3g modem sms demo

The description of the demo can be found by downloading the latest version from ICP DAS web site.

http://ftp.icpdas.com/pub/cd/winpac imx6/wp-2641/document/faq/development/

W5-14 How_to_use_the SMS function_and_get the GPS data_en
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http://ftp.icpdas.com/pub/cd/winpac_imx6/wp-2641/document/faq/development/

A.5.3. How to Synchronize the System Time by GPS Data

The demos can be found by downloading the latest version from ICP DAS web site.

http://ftp.icpdas.com/pub/cd/winpac imx6/wp-2641/demo/3g modem/gpstimesynchronization

The description of the demo can be found by downloading the latest version from ICP DAS web site.

http://ftp.icpdas.com/pub/cd/winpac imx6/wp-2641/document/faqg/development/
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Appendix. B. XV-Board Modules

The XV-board series are for LP-2641M, WP-2641M-CE7. One PAC
can only plug only one XV-board. The XV-board series have
following common specification:

* Dl channelis dry contact, sink type.

* DO channelis open collector, sink type.

DIO Expansion

DI DO
Sink/Source Sink/Source

XV107 Source Sink

8 Wet 8
XV107A Sink Source
XV110 16 Dry/Wet Sink/Source - -
XV111 Sink

- 16
XV111A Source

Relay Output Expansion

Relay Output
Channel Sink/Source Channel
2 Signal Relay
XV116 5 Wet Sink/Source
4 Power Relay

Multi-Function Expansion

Channel Sink/Source Channel Sink/Source
XV308 8 - DI+D0O=8 Source Sink
Dry/Wet DI+DO=8
XV310 4 5 4 Sink Source

For more detailed information about these support modules, please refer to

http://www.icpdas.com/root/product/solutions/hmi touch monitor/touchpad/xv-board selection.html
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Appendix. C. Revision History

This chapter provides revision history information to this document.

The table below shows the revision history.

Revision | Date Description

1.0.1 February 2020 Initial issue
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